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Sending Mail Messages

This screen allows you to prepare new mail messages and replies.

Addressing your message
The subject field
Confirmation of reading
Confirmation of delivery
Keeping a copy of your message
Urgent messages
Encryption
Signatures
Editing your message
Attachments
Other message options
Importing text from other sources



Addressing your message

Just as the postal service needs an address to be able to deliver a letter, WinPMail requires an address to 
be able to send your electronic mail. Depending on your system and network you might be able to use any
of several types of address, each slightly different. The following are the types of addresses WinPMail 
recognizes, which you can enter in the To, CC or BCC fields.

Local addresses: You can enter the NetWare username of any user on your file server, or on any other 
file server to which WinPMail can deliver, using the standard NetWare syntax (ie, USERNAME, or 
SERVER/USERNAME). You can look up local users using the User Lookup function.

Internet Addresses: If your system has an SMTP gateway, then you can enter any valid Internet 
address in the address fields.

NetWare MHS Addresses: If your system has an MHS gateway then you can enter any valid NetWare 
MHS address in the address fields. If you are using an advanced MHS transport, you can access MHS
directory services from the Addresses menu.

You can also prepare distribution lists, or lists of addresses you use frequently.



The To: field of a message indicates the primary recipient of a message



A CC (carbon copy) recipient of a message is someone you want to "listen in" to the message you are 
sending to the primary recipient. CC recipients receive the message normally but their addresses do not 
appear in the To: field of the message.



Use a BCC (Blind Carbon Copy) when you want to send a copy of your message to someone other than 
the primary recipient without the primary recipient knowing you have done so. Unlike CC, when you use 
BCC, there is no indication in the primary recipient's copy of the message that you have copied anyone 
else. BCC is very handy for office politics.



An SMTP gateway allows you to send mail to machines on the Internet (a huge world-wide computer 
network), or to machines which use the Internet RFC821/822 message protocols. Almost all Unix systems
and many mainframe and minicomputer systems can receive mail using this protocol.



NetWare MHS is Novell's messaging system. There are several versions of it for both NetWare and non-
NetWare environments. WinPMail supports all versions of NetWare MHS, including NetWare Global 
MHS. Ask your system administrator if you're unsure whether or not this option is available on your 
server.



The Subject field

Enter a short summary of your message in the subject field. Because the recipient will use the subject line
as a filing key, you should try to make it as descriptive and helpful as possible. When replying to a 
message, it is customary for the subject to be Re: <the original subject>: WinPMail will automatically 
format the subject this way for you when preparing replies.

The subject field can be up to 64 characters long.



Confirmation of reading

If you want to be notified when the recipient reads your message, check the confirm reading box in the 
message editing window. A small message will be sent back to you when the message is read. Note: the 
recipient must be using a version of Pegasus Mail for receipt confirmation to work. Some MHS mail 
systems may also be able to provide receipt confirmations.

The System administrator can allow users to refuse confirmation of reading because many people feel that
it is an invasion of privacy. If you attempt to mail to a local user who will not provide confirmation of 
reading, a small dialog will appear when you send the message advising you of this. If you mail to a non-
local Pegasus Mail user who will not permit confirmation of reading you will not receive any notification 
at all.

The confirm reading control is "sticky" - WinPMail will remember its setting from message to message 
and between sessions.



Confirmation of Delivery

Checking the confirm delivery box in the message editing window tells WinPMail to ask for confirmation 
that your message has been delivered successfully. Confirmation of delivery differs from confirmation of 
reading in that you are only advised that the message has been delivered to the recipient, not that it has 
been read.

Confirmation of delivery is always available if you are using NetWare MHS. You will never get 
confirmation of delivery on local mail (because WinPMail will tell you immediately if it fails to deliver 
your message). With Internet mail, you may or may not receive confirmation of delivery, because there 
are no guaranteed ways of asking for it.

The confirm delivery control is "sticky" - WinPMail will remember its setting from message to message 
and between sessions.



Keeping a copy of your message

If you want to keep a copy of the messages you send, check the copy self box in the message editing 
window. WinPMail will file a copy of your message in a folder called "Copies to self" which it will create
automatically when necessary. WinPMail can also ask you whether you want a copy to self on a message 
by message basis, and can prompt you to select a folder for the copy to self at the time the message is sent
(see the Special view of the message editor for these settings).

If your "Copies to self" folder becomes too full, you can force WinPMail to create a new copyself folder 
by renaming the existing one. Note that you must change the short name as well as the long name when 
doing this.

The copy self control is "sticky" - WinPMail will remember its setting from message to message and 
between sessions.



Urgent Messages

Check the urgent box in the message editing window if you want your message to be sent at the highest 
priority available on the message transport your system uses. The effect of setting this flag will vary from 
system to system. Many MHS mailers will recognize it, as will some Internet mailers. Pegasus Mail 
displays urgent messages at the top of the new mail folder in red text, and sends a different new mail 
notification to the recipient to indicate that the message is urgent.

Note: You should use the urgent flag with care: urgent messages can be annoying, and overuse of the 
feature seriously impacts on its usefulness.



Pegasus Mail's encryption module

If your message contains sensitive or private information, you might want to encrypt it. An encrypted 
message is scrambled, and can only be read by someone who knows the correct password. You can 
encrypt your message using Pegasus Mail's built-in encryptor, or if you have one, using a third party 
encryption module.

To encrypt your message, click the Encrypt button in the message editor. A small dialog will open into 
allowing you to select an encryptor. If you choose Built-in encryptor (the default) then you can enter a 
password using the following rules: the password should have from five to eight characters and is case-
sensitive - so FOOBAR and foobar are different passwords. Press OK to add the password, or Cancel to 
remove it. WinPMail will encrypt the message using your password when it sends it.

The recipient must know the password, so you will have to make arrangements in advance to agree on a 
suitable choice. Don't forget the password! If you forget it, you will never be able to read your message 
again; even the author of WinPMail cannot break the encryption method it uses.



Signatures

A signature is a small fragment of text which WinPMail will automatically add to the end of messages 
you send. You should usually put your name, address and phone/fax number in your signature, although 
some people like to place a witty saying or other text there as well.

Pegasus Mail supports nine different signatures that you can select on a message by message basis. 
Because Pegasus Mail supports a variety of message formats and delivery transports, each "signature" is 
actually a set of three signatures - one that Pegasus Mail will attach any time you send mail locally using 
its own built-in delivery agent, one that will be attached to Internet mail messages you send, and a third 
that will be attached to any messages you send via Novell MHS (if you are using it). Note that the 
selection of a signature is based on the transport mechanism, so if you send a message to a user on your 
file server but do so via an Internet transport such as Mercury or Charon, your Internet signature will be 
attached to the message.

Why do you need signature sets? Usually the information you present in your signature will include 
things like your e-mail address, which may be different on different transports. For example, if you are 
sending Local and Internet mail you may well express your address differently (possibly 
"THALIA/DAVID" for your local address, but "david@pmail.gen.nz" for your Internet address). Having 
separate signatures for each transport allows you to present information that is appropriate in each 
environment.

To edit a signature set, select it from the Signatures submenu of the Preferences submenu of the File 
menu. You do not have to create signatures for transports you do not use, so if you only ever send Internet
and Local mail, you do not have to create an MHS signature.

To select a signature set for your mail message, click the Signature check box in the message editor. This 
will open a dialog allowing you to choose from any of the nine possible signature sets. You can tell 
Pegasus Mail to use any of the signature sets you have defined as the default signature set for future mail 
messages by checking the Use as default from now control. To disable a signature for the current message,
check the radio button labelled Add no signature to message.

Variable signatures:    Pegasus Mail can place a piece of text selected at random from a list you provide in
your signature -- for more information on preparing a variable signature, examine the sample quotes file 
RQUOTES.R in the RESOURCE\ subdirectory of the directory where you installed WinPMail. To flag the
location in your signature where you want the variable text to be placed, use the special characters ~!. Be 
careful when using variable signatures -- people's tastes differ hugely all around the world, and something
which seems witty to you may be offensive to other people.



Editing your message

Edit your message in the large message box at the bottom of the message editing window. The message 
text will word-wrap when it reaches the right hand margin, or you can press <Enter> to end a line at any 
time. You can cut text from and paste text into your message using the Edit menu.

You can check your spelling by positioning the cursor at the point in the message where checking should 
begin and selecting Check spelling from the Tools menu.

Ctrl+Y deletes the current line in the message, Ctrl+T deletes the word to the right of the cursor, and 
Ctrl+B reformats the current paragraph so that all its text falls between the left and right margin. Ctrl+D 
opens the Indenting dialog, which contains commands which allow you to reformat your text with 
indented left and/or right margins. These reformatting commands can also all be selected from the 
Message menu.

You can store abbreviations for commonly-used text in WinPMail's glossary, and expand it at any time by
pressing <Ctrl+E>.

Send your message at any time by clicking the Send button, or by pressing <Ctrl+Enter>.



Attachments

You can attach files to your mail message by clicking on the Attach button in the message editing 
window. The message editor view will change to one which allows you to choose files and control the 
way WinPMail will deal with them.

WinPMail will handle your attachments differently, depending on the destination of the message. You 
have considerable control over this process if you wish to have, although WinPMail's automatic handling 
is usually more than adequate for all situations.

Choose any of the following items for more information on attachments:

Selecting files to attach
Indicating the file type
Attachment encoding



Selecting files to attach

Before you select files to attach to your message, make sure that the File type and Attachment encoding 
fields in the dialog are set correctly, then use either of the two following methods:

Use the file and directory lists at the bottom of the window to navigate your disks. Double-clicking a 
filename will add it to the attachment list with the current settings of the file type and attachment 
encoding fields.

Type in the name (including an optional DOS path) of the file in the filename window. When you 
press <Enter> or click Add, WinPMail will add the file to the attachment list, or if you have entered a 
directory name, will change the file and directory list boxes to reflect the new directory.

You can remove attachments from the attachment list by highlighting them and clicking Remove. You 
cannot change the settings for an attachment once you have added it to the list - remove it and re-add it 
instead.



File type

You can tell WinPMail what type of file you are attaching by choosing from a predefined list of file types.
The file type information is optional and is currently used only for informational purposes - the recipient 
will usually see then file type when examining the list of files attached to the message.

The file type information can be used to provide attachment viewing facilities, or to launch the original 
application with the attachment, so you should get into the habit of filling it in.

If you are uncertain of the type of file, you should use Unknown, the default choice.

Note: Pegasus Mail will not perform file conversion - WinPMail will not convert an MS-Word file to 
WordPerfect format even if you indicate WordPerfect format here - it will simply convey the wrong 
information. It is up to you to ensure that the file type information is appropriate for the file you are 
attaching.



Attachment encoding

When you send an attachment, it cannot always be transmitted as-is. Sometimes it is necessary to package
the attachment in a particular way so that the mail transport system or the recipient's mailer can 
understand it. WinPMail will always make sensible default choices about attachment encoding - you 
should only need to change the attachment encoding in very special cases. WinPMail supports the 
following attachment encodings:

WinPMail decides. The default setting, this tells WinPMail to do whatever is appropriate based on the 
way it sends the message. Attachments to local and MHS addresses will not be encoded in any way, 
while attachments to Internet addresses will be uuencoded prior to transmission.

No encoding. Instructs WinPMail not to encode the attachment at all. This is an extremely dangerous 
choice in some cases, particularly for Internet mail. Use it only if you know that the attachment is a 
plain text file with no high bit characters.

ASCII text. Indicates that the file is plain text with no formatting or high-bit characters. WinPMail 
will actually send the attachment as a separate message rather than as an attachment.

UUencoding. A scheme used widely on the Internet. If you are mailing via the Internet, or to a user on
a Unix or mainframe system this encoding is a good choice.

BinHex. Used heavily in the Macintosh world. BinHex is a good format, containing a certain amount 
of error checking and compression. Because it is not widely used outside the Macintosh world, you 
should check in advance that the recipient is able to deal with BinHex-encoded files.

MIME Encodings:    MIME (Multipurpose Internet Mail Extensions) is an Internet standard for 
multimedia mail which allows different mail applications to exchange a variety of types of 
information. If you select any of these MIME encodings, WinPMail will attach the information 
necessary for other applications to be able to decode the file. You must choose an appropriate 
translation - selecting "GIF image" for a TIFF file will not cause Pegasus Mail to convert the file: it 
will simply be sent in the wrong format. Pegasus Mail will choose basic MIME encoding 
automatically if you set encoding to "WinPMail decides" and have checked the "Use MIME features" 
control in the "Special" screen of the message editing dialog.



Other message options

Select Other message options from the Message menu, or click on the "Special" button in the message 
editing dialog and the screen will change to a dialog which allows you to control less frequently-used 
features for your message.

BCC. Enter any BCC. addresses in this field.

Send replies to. If you want replies to your message to go to an address other than your own, enter that 
address in this field.

Use MIME features for Internet and local mail    MIME is an an Internet standard that allows mailers on 
different systems to exchange binary data and messages using International characters. If you check this 
control, WinPMail will use MIME encodings to represent accented and special characters, and to package
attachments so that other MIME-compatible mail systems can read and convert them. MIME is a very 
powerful standard, and the only time you should not check this control is if you believe your 
correspondent may not be using a MIME-compatible mail system.

Message is obsolete after. If your message is only meaningful for a certain length of time, enter the time 
after which it is obsolete in this area. Obsolete messages appear grey in the folder window, and there is a 
browser command which will purge all obsolete messages. Obsolete mail mail also be purged by utilities 
run by the system manager.

Message width. This field allows you to specify the average length of a line of text in your message. 
WinPMail will adjust the margin of the message editor so that approximately the number of characters 
you specify will fit on a line. You cannot enter a width wider than the current width of the editing 
window.

Average tab width. By default, WinPMail obeys the standard Windows convention that the <Tab> key 
moves from field to field in a dialog. If you enter a width in this field, however, WinPMail will insert the 
<Tab> characters in the message instead. You can only change the tab width if tabs were enabled when 
you started the message. The width you enter is an average based on the average width of characters in 
the current font; it will only be exact if you use a monospace font such as Courier.

Custom headers    This option allows you to add specific message headers directly into the mail message 
generated by Pegasus Mail. It is a very technical option and should only be used if you know exactly what
you are doing. Click Add and Pegasus Mail will open a window prompting you to enter the header you 
want to add. Type it in exactly as it should appear in the message, including the keyword and the colon 
character following it. You may not add any header that Pegasus Mail itself will add to the message, so 
you cannot add fields like From, To, Subject, CC, MIME-Version, Content-type and so on. The principal 
use of this feature is for list managers who need to add approval headers when submitting messages, and 
for internal use by Pegasus Mail itself, which uses it to attach special threading headers to your replies.



Importing text from other sources

You can add text from other applications to your message in two ways.

Cut and paste. You can use the standard cut, copy and paste commands on the Edit menu to move text 
around within Windows.

Import menu option. The Import file into message option on the Message menu allows you to read a text 
file into your message. A dialog will appear which allows you to navigate using standard file and 
directory lists, or type the name of the file in directly. Note: the file must be a text file for this option to 
work. Word processor files are usually not text files.



Distribution Lists

WinPMail can accept up to 180 characters in any address line. If you need to send a message to more 
addresses than will fit in this space, or you have lists of users to whom you mail regularly, you can create 
distribution lists.

A distribution list can be any text file containing addresses, one per line, but it's generally easier to use 
WinPMail's distribution list manager, which you can access by pressing the button on the button panel, by
pressing <F6>, or by selecting Distribution lists from the Addresses menu.

Creating a distribution list
Distribution list options
Using distribution lists



Creating a distribution list

To create a distribution list, press <F6> and click on the New button in the selector window. A dialog will 
open prompting you for a long name for the list and an optional file name. Complete the dialog then click 
OK. You will be returned to the selector window.

Now, highlight the list you created and press the Edit button. A window will open in which you create and
control your distribution list. The title you gave your list when you created it appears in the Title field.

To add addresses to your distribution list click in the address list area and either type in the addresses or 
select them from address books or the local user list. Make sure that you have only one address per line in
the list. Any valid address can be entered in the list.

Distribution list options



Distribution list options

There are several ways you can control and customize the operation of your distribution lists.

To field: Entering an address in this field will force Pegasus Mail to suppress the listing of all the 
recipients' addresseses in the To: field when you use the list. Instead of showing every member of the list, 
the To: field will contain only what you enter here. Because of the way Internet mail works, you cannot 
simply enter any piece of text in this field -- you must enter something which can be legally processed as 
if it were an address. We recommend that you use the following format to create the contents of this field:

"(descriptive text)" <(your own address)>

Replace (descriptive text) with a meaningful name for the mailing list, and put your own address where it 
says (your own address). Recipients will almost always see the descriptive text instead of your address so 
it will not seem as strange as it sounds. The quote characters around (descriptive text) and the angle 
bracket characters around (your own address) are vitally important and must be included exactly as 
shown. It is not possible to suppress the recipient list for MHS mail and this field will be ignored for 
MHS messages.

Reply to: If you want to direct replies to list mailings to a particular address, enter it here. A reply-to field 
you set in the list will override any in the message.

Confirm reading, confirm delivery, urgent, no signature: These controls duplicate the same features in the 
message editor. If you set them for the distribution list they will override the values you use when you 
compose the message.



Using a distribution list

Tell WinPMail to use a distribution list in one of three ways:

1: While composing your message, open the distribution list selector by clicking the button in the button 
panel, by pressing <F6> or by choosing Distribution lists from the Address menu, and double-click on the
address you want to use. WinPMail will paste the appropriate file name into the address field of your 
message.

2:    Leave the distribution list manager window open and drag the lists you want to the address field in 
your message.

3: Type an '@' followed immediately by the DOS path to the file containing the distribution list. You will 
not normally use this method, but it may be convenient if you have a mailing list in a suitable format 
which was not created in WinPMail.



Glossaries (abbreviations)

WinPmail allows you to store abbreviations for commonly-used text strings which you can expand at any 
time with a single keypress. To create a glossary entry, choose Edit/create from the Glossary submenu of 
the Edit menu.

In the Glossary dialog, a list of abbreviations appears on the left-hand side of the screen, while the full 
text of the currently-selected abbreviation appears in the edit window to the right. To change a glossary 
entry, simply select it in the list and edit it in the editing window. WinPMail. Adding a glossary entry is 
equally simple - just click the Add button, provide an abbreviation, and edit as before. You can copy and 
paste into your glossary texts using the buttons in the dialog.

To expand a glossary entry in your message, simply type the abbreviation, make sure the cursor is at its 
end, then press <Ctrl+/> or <Ctrl+E>. You can currently only expand glossary entries in the message 
editor. Future versions will allow you to expand them in any text field.



Browsing mail

The folder browser allows you to manage the mail you receive. It provides functions for moving, copying,
deleting, forwarding, printing and replying to messages. Special options and functions for sorting folders 
are located on the Folder menu which appears at the end of the menu bar when a folder window is 
frontmost.

Message status indicators
The Folder Manager
The folder selector
Copying and moving messages
Deleting messages
Forwarding messages
Printing messages
Annotating your messages
The Folder menu



Annotations

You can add your own comments to any message you receive in a number of ways:

* By choosing Add/edit annotation from the Folder menu while browsing a folder, or from the Reader 
menu while you are reading a message.

* By double-clicking on the message line in the folder browser in the location where the "annotations" 
status indicator appears or would appear. Messages with annotations appear marked with a green dot 
status indicator in the folder browser.

Annotations are stored in a separate file from the message and are automatically deleted when you delete 
the message. You may put whatever you wish in an annotation - Pegasus Mail does not impose or suggest 
any particular format. When you move a message to another folder, its annotation will move with it.

Note: If you make a copy of a message with annotations then delete either the original or the copy, the 
annotations will be deleted as well.



Message status indicators

Pegasus Mail reserves a small space at the left-hand side of the folder window to place status indicators 
that give you visual information about each message.

The attachment indicator will be a dot if the message has conventional attachments, and will be a solid 
square (as shown in the diagram) if the message is a MIME multipart message.

Triangle indicator    If a message has a solid black triangle next to it, that indicates that it is in a special 
format called Multipart/Alternative. This format contains more than one version of the same mail 
message - usually varying in format. As an example, someone might send you a message that contains 
both a fully-formatted rich text version (with font changes, bold, italic and so on), and another version of 
the same message formatted as plain text. The idea of Multipart/Alternative messages is to allow the 
receiving mail program to display the format it is most capable of handling. Pegasus Mail displays the 
plain text version if it is present. You can open the message as a regular multipart message and see all the 
versions it contains by holding down Alt as you double-click on the message's entry in the folder.



A mail folder is simply a place where mail messages are stored. The new mail folder is a special folder 
which changes as you receive, read and delete mail, but you can also create other folders for long term 
storage of messages you wish to keep. Folders can have long descriptive names to aid in filing.



The folder selector

When you choose the Move or Copy options in the folder window, the folder selector will open. In this 
dialog you can create new folders, rename existing ones and delete folders you no longer require.You can 
also create Trays, which are a special kind of folder which can contain folders and other trays.Trays allow
you to organize your mail into a hierarchy, or to group related topics and folders in their own areas.

The folder selector shows a list of all the folders and trays available to you. Folders in the list which 
appear in blue are system folders: you can read from them, but you might not be able to alter their 
contents. You can select items from the list using the mouse, or by typing the first few characters of their 
names. To open a tray, highlight it and press <Enter>, or click on the Open button, and its contents will 
appear in the list indented one level.

At the right-hand edge of the entry for each folder is a pair of numbers, representing the number of 
messages in the folder and the number of unread messages in the folder respectively. Unread mail can 
appear in folders as a result of new mail filtering rules, or when you copy a message you have not read 
from the new mail folders. Folders containing unread mail appear in the list in green.

Special options    When you click the Special button in the folder selector, a popup menu will display 
offering the following four options; you can dismiss the menu without selecting a choice by pressing 
<Esc> or clicking the mouse outside the menu.

Reindex folder    From time to time, a folder's index file may become corrupt, which can result in errors 
when you attempt to open it. Highlight the folder and select this command to force Pegasus Mail to 
rebuild the index file. Reindexing will work reliably if the actual messages in the folder are intact, but 
may result in the loss of some status information (such as whether or not you have replied to a message, 
or forwarded it). A side-effect of rebuilding a folder is that some deleted messages may reappear the next 
time the folder is opened.

Compress folder    When you delete a message from a folder, Pegasus Mail does not immediately reclaim 
the space it occupies; instead, it waits until you have deleted around 20000 characters from the folder then
recovers all the space in a single pass. This deferred compression improves the performance of the 
program at the cost of some disk space. Select this option to force Pegasus Mail to compress a folder. 
Compression is always a safe option and does not result in the loss of information.

Move entry    Select this if you want to move a folder or tray to another tray. The highlighted folder or tray
will be removed from the list and information about it will be saved in a disk file (called 
TRAYSAVE.PM) in your home mailbox. Once you have chosen the Move command, each time you click
the Special button again, the Move option will be replaced by a Retrieve option, allowing you to insert the
moved entry into the list. Navigate to the place in your tray hierarchy where you want the item to appear, 
then choose Recover from the special menu and Pegasus Mail will insert the saved item for you. It is safe 
to exit from Pegasus Mail without recovering the entry - you can do it at any time after you have moved 
it.

Check tray list    If you create folders using an old version of Pegasus Mail after you have run WinPMail 
1.1, the folder will not appear in the tray list, because WinPMail stores the tray structure in a way which 
the old version of Pegasus Mail does not understand. Selecting this option tells Pegasus Mail to compare 
its tray list (the list of all folders and trays which it maintains) with the folders which actually appear in 
your home mailbox. If it finds any folders which are not in the tray list, it will add them to the main tray 
for subsequent use. This command is completely safe and may be used routinely if you wish.



Copying and moving messages

If you want to make a copy of message in a mail folder, or to move the message from the current folder to
another, click on the Copy button or the Move button. The folder selector will open listing the available 
folders. You can create a new folder if you wish, or else double-click on the destination folder.

Pegasus Mail also provides a feature called Quick Folders which can help you file mail to your most 
commonly-used folders more quickly.

If the message you are copying has not been read, the unread messages counter which shows for the 
folder in the folder selector will increase by one.



Deleting messages

To delete messages you no longer need, highlight them in the folder and click the Delete button, or press 
the <Del> key.

Deleted message tracking: WinPMail has a preferences option which can allow you to recover mail 
messages you delete accidentally. If you have checked Preserve deleted messages until exit in your 
preferences WinPMail will not delete messages from the folder - instead it will move them to a special 
folder called Deleted messages which it will create as necessary. When you exit from WinPMail, the 
deleted messages folder is removed and the messages are deleted once and for all. Any time up to the 
point when you exit from WinPMail you may open the deleted messages folder and move or copy 
messages you wish to recover to other folders.

Note: you should not enable deleted message tracking if you are running in an environment with low or 
restricted disk space.



Forwarding messages

If you wish to refer a message to another person or people, then highlight it in the folder list and click the 
Forward button, or press <F>. A small dialog will open prompting you for the address to which the 
message should be forwarded. If you click Edit before forwarding, then a message editor will open 
allowing you to change the contents of the message before it is sent, otherwise it will be forwarded at 
once.

If the message has attachments, you can choose whether or not to forward them as part of the message by 
clicking the control labelled Forward attachments as well.

When forwarding a mail message, WinPMail changes the subject field so that it starts with the phrase 
(Fwd), to indicate that it has been forwarded.

All standard address selection options except <Shift+F3> (to expand an address book key field into a full 
address) are available in this screen.

Note: It is presently a restriction of the program that if you forward a multipart MIME message with 
changes, the multiple parts will not be accessible to the final recipient. To get around this, we recommend 
that you forward the message twice, once without changes, to preserve the multiple parts, and the other 
time with changes to include your edits.



Forwarding multiple messages

If you select Forward when more than one message is selected in a folder, there are a number of ways 
WinPMail can proceed:

1: It can open a separate forwarding window and allow you to address each message separately.

2: It can forward all the messages to a single address: in this case, it will open a single window asking you
for the forwarding address, and each message will be sent separately. The recipient will receive one 
message for each message you forward.

3: It can package all the messages into a specially-formatted message called a digest, then send that digest
to the recipient. If the recipient is using Pegasus Mail, or another mail package that supports the MIME 
digest format, then the message will behave in many ways like a folder when opened, displaying a 
summary of each message and allowing the recipient to browse the messages individually.

When you choose option 2 or 3, WinPMail will open a modal dialog window - one that will not let you do
anything else until you have finished forwarding the message. It does this to prevent you from 
accidentally going back to the folder and altering the messages that are selected there, since altering the 
selection will result in the wrong messages being forwarded. A side-effect of this limitation is that you 
cannot access any other WinPMail window (such as your address books, or the distribution list manager) 
when you forward messages using options 2 and 3. The recently-used addresses list is available though, 
and you can either type an address into the dialog or else paste it, having copied it before you chose 
Forward.



Printing messages

You can print messages from the message reader or from the folder list by pressing <Ctrl+P>, or by 
selecting Print from the file menu. The message reader also has a Print button.

When you ask to print a message, the print setup dialog will appear showing the last settings you used. 
WinPMail remembers your print settings from session to session. The currently selected printer (or the 
default Windows printer if this is the first time you have printed your message) appears in the list control. 
You can select other installed printers by clicking on the down arrow at the right-hand end of the control.

Print which message headers?    Pegasus Mail lets you choose how much or little of the message's headers
it will print. Choosing Significant, full will print the headers you normally see in the message reader in 
their entirety, while Significant, first line prints only the first lines of only those headers. Clicking All will 
print the message exactly as it was received, with all headers intact, and clicking None will omit the 
header information from the printout altogether.

The Margin fields allow you to specify a printing margin for the Top/Bottom and Left/Right of the page. 
The default is 20mm (one inch = 25.4mm) all round. WinPMail will not permit you to set margins 
narrower than 10mm. 

The Font button allows you to select a font from those supported by your printer.

The Setup button brings up the standard Windows printer setup dialog, which will vary from printer to 
printer.



The folder menu

When a folder window is frontmost, a Folder menu appears at the right of the menu bar. The folder menu 
contains options which are less frequently-used or are more specialised than the button functions in the 
window.

Searching for text in the folder
Sorting the contents of the folder
Extracting messages to files
Special folder options
Quick folder options

Set colour allows you to display messages in different colours, which can be a useful way of reminding 
yourself about their contents. You can sort your message by colour as well.

The last entry on the menu allows you to select the font the folder window will use to display the list. This
setting is global to all folders and is remembered from session to session. You cannot choose very large 
fonts for the folder display without truncating some of the information it shows. A 14-unit font is 
normally a good size.



Searching for text in a folder

The Find and Find again options on the folder menu allow you to search the contents of the current folder 
for a piece of text. Type the text you want to look for in the editing field. The text can contain * and ? 
wildcard characters. Unless you use wildcard characters, the search is case-sensitive (that is, WinPMail 
and winpmail are regarded as different).

Search message headers only: If you want WinPMail to restrict its search to the special headers at the 
start of the mesage, check this box. Searching headers only is considerably faster than searching the 
whole message, and is appropriate if you are interested in the subject of a message or who it is from.

Mark all matching messages: Usually WinPMail opens a message reader and displays the first message it 
finds which matches your search criteria. If you want to select all messages in the folder which match 
your criteria instead of reading them, click this box. This option is handy if you want to tag all messages 
on the same subject for moving or copying.

Hint - searching for a specific header: If you only want to search for a particular header containing your 
search string, make sure that search message headers only is checked, then enter the search text like this 
example, where we only want messages where the From: field contains the word Otago:

From:*otago*



A wildcard character is one which matches any character or group of characters in the text searched. In 
WinPMail the ? character matches any single character (so "?illy" will match both "Willy" and "Billy"), 
while the * character matches any number of characters (so "j*on" would match "johnson", "johnston" or 
"john's son").



Extracting messages to files

Select this command if you would like to save the text of a message or messages to files on your hard disk
or file server. What happens when you select this option depends on whether or not you have selected 
more than one message in the folder. If you have only selected one message, the Pegasus Mail will simply
ask you for a filename and will save the contents of the message to that file. If you have more than one 
message marked, then Pegasus Mail will open a dialog asking you to choose from three options:

Extract all messages to a single file    If you choose this option, then Pegasus Mail will ask your for a 
filename and will save the text of all the marked messages in the same file, one after the other in the order
they appear in the folder.

Extract messages to separate files, asking for names    Choose this option and Pegasus Mail will ask you 
for a filename for each marked message. You will usually use this option when it is important that you 
control the names of the files containing the message text.

Extract to separate files, creating unique names for each    If you choose this option, then Pegasus Mail 
will ask you to enter a single filename. It will then take the filename you supply and create unique 
filenames based on it, saving the text of each message in a separate file. Pegasus Mail creates the unique 
names by removing any file extension you supply and adding a numeric extension starting at 000, adding 
1 to the extension for each file.You can extract a maximum of 999 messages to files using this command.



Sorting folders

The second group of entries on the Folder menu allow you to specify how the folder should be sorted. The
default for folders is Sort by date. A check mark appears next to the entry which indicates how the folder 
is currently sorted.Most sorting options will perform a secondary sort when the primary sort fields are 
equal; for sorting by subject, you can choose to sub-sort either by date or by reverse date.

Sort unread before read splits the folder into two groups of messages - those which have been read and 
those which have not. Each group is sorted according to the current sort order, but all your unread mail 
appears above read mail in the list.

Sort by colour allows you to sort your mail on arbitrary criteria; use the Set colour option on the menu to 
display your messages in any of 15 colours, the use "sort by colour" to group them together, sub-sorted by
date. You can also set a message's colour using the Highlight action in your new mail filtering rules.

The section header panels in the folder window are buttons which can also be clicked to select a sort 
order.

You can sort by reverse date by holding down Ctrl as you click on the Date/time or Subject buttons.

WinPMail remembers the sorting option you select from session to session.



Special folder options

The Special entry on the Folder menu has a submenu containing specialised or infrequently-used 
functions.

UUdecode message: Sometimes WinPMail will be unable to recognize that a message is actually an 
attachment sent using a special encoding method called uuencoding. This usually happens if the 
attachment was sent across the Internet by someone using a mail system other than Pegasus Mail. If you 
receive a message like this, you can force WinPMail to decode it by highlighting it in the list and 
selecting this option. WinPMail will prompt you for a filename and will attempt to decode the message 
for you.

Un-BinHex message: BinHex is another special transmission format like uuencoding (see above), 
commonly used on Apple Macintoshes. If you receive a BinHexed message which WinPMail does not 
recognize as BinHexed, you can force it to unpack it using this option.

Note: BinHexed files from Macintosh users may be useless to you on a PC. The Macintosh has a filing 
system quite unlike that of any other computer and its files are often only usable on other Macintoshes. 
Some programs such as WordPerfect and MS-Excel create data files which are compatible on both 
platforms, but not all do. If you find you cannot use the attachment when you extract it, this may well be 
the reason.

Mark messages as unread:    If for some reason you wish to change the status of a message from having 
been read to not having been read, either choose this option or press <Ctrl+U>; all messages selected in 
the current folder will be marked as unread. Note that marking a message as unread in the new mail folder
means that any new mail filtering rules you have defined will be applied to it again the next time you 
open the new mail folder, and that if the sender has requested confirmation of reading, he or she will 
receive another confirmation the next time you read the message.

Delete all expired messages: WinPMail allows you to set an expiry, or obsolescence date for a message - 
a date after which the message is meaningless; messages which are past their expiration dates appear grey
in the folder window. This command instructs WinPMail to delete all expired messages from the folder, 
and only works in the New Mail folder.

Add sender to distribution list  When you select this command, Pegasus Mail will open the distribution 
list selector and prompt you to select a list. The addresses of the sender of every marked message in the 
folder will be added to whichever distribution list you select. WinPMail will not duplicate an address 
which already appears in the list.

Remove sender from distribution list    This command removes the sender of every marked message in the 
folder list from whichever distribution list you select.



Address books

WinPMail's address books allow you to store electronic mail addresses and other information about 
people with whom you correspond. You can create as many address books as you wish, and the system 
administrator can also create address books which everyone can see (these appear in blue in the address 
book selector window).

The address book selector
Creating addressbook entries
Using addressbook entries in your mail
Searching address books
The address book menu

Hint: to add a user's address to an address book, drag a message from that user out of the folder and drop 
it on an open or minimized address book.



The address book selector

When you click on the address books button, or choose address books from the Addresses menu, the 
address book selector window will open. In this dialog you can create new address books, rename 
existing ones and delete address books you no longer require.

The selector shows a list of all the address books available to you. Address books in the list which appear 
in blue are system-wide address books available to all users: you can read from them, but you might not 
be able to alter their contents.

To open an address book, either double-click its entry, or highlight it in the list and click on the Open 
button.

Naming address books: when you create an address book in the selector, you can give it any name you 
wish up to a maximum of 50 characters. There are no restrictions on the names you can use in the address 
book long name. If you choose to specify the short name (or filename) for the address book, you must 
enter a legal DOS filename no longer than 8 characters with no extension. Usually, you will leave the 
short name field blank and allow WinPMail to choose a filename for you.



Creating address book entries

When you have opened an address book, a window will open listing the contents of the book in an 
abbreviated form. If you click on an entry in the list, all the details from that entry will appear in the 
information pane at the bottom of the address book window.

To add an entry to your address book press the Add button. A simple data-entry dialog will open 
presenting you with a blank entry template. Fill in the fields and when you are satisfied with what you 
have entered, click the OK button. The fields which you must complete in this screen are the following:

Name (alias): The person's name. You can use what you enter in this field as an address in any address 
field - it is generally easier to remember that someone is called Peter Smith than to remember his address. 
This use of the name as an address is called aliasing. This field may not contain a comma.

Key: A short search key for the entry. WinPMail allows you to sort the address book either by name or by 
key, so the key field gives you an alternative sorting option.

E-mail address: The person's electronic mail address. Any single valid address can be entered in this field,
including distribution lists and NetWare groups. You may not use an alias in this field.

All other fields in the address book are yours to use in any way you wish.



Using address book entries in your mail

You can use your address books in your mail in three distinct ways

1: You can double-click on an entry in your address book to start a new mail message using that address 
and any others selected in the book.

2: You can click on the Paste button on the address book window. Any highlighted addresses will be 
copied into the last active field in the message you are editing.

3: You can drag the address entries you want to use to any edit control and drop them there. Note that the 
edit control need not be in WinPMail - it is possible to drag addresses from WinPMail to edit controls in 
other applications, such as the Windows Notepad program.

Depending on the setting in the address book menu, WinPMail will paste either the alias (the default) or 
the actual e-mail address into the destination field: you may use either approach depending on your 
preference.

Limitations:    Most address fields in WinPMail can only accept at most 256 characters. If you have 
selected addresses with more characters than will fit in the field, WinPMail will issue a warning. When 
this happens, you might have to consider creating a distribution list.



Aliasing happens when you use the name field from an address book instead of the e-mail address. 
WinPMail will accept either as an address: if you use the name, then WinPMail will look up the real e-
mail address at send time. You may prefer to use aliases over e-mail addresses because it is generally 
easier to remember someone's name than their address.



Searching address books

The quickest way to search your address book is to type the first few characters of the name or key you 
want to find. Depending on the current sort order of the address book WinPMail will move the highlight 
to the first entry in the book with a key or name which matches what you type. This process is called 
speed searching.

For more comprehensive searching, the Edit menu contains a Find text command that you can use to 
locate or select entries in your address books. When you choose Find, a small dialog will open asking 
what you want to search for. Enter the string you want to find. If you want WinPMail to search the whole 
address book marking all entries which match your criteria, click the select all matching entries button.

You can repeat the last search you made by selecting Find again from the Edit menu. The search text is 
global, so you can search in one book, then open another and choose Search again to continue your 
search in the new book.



The address book menu

When an address book is the frontmost window in WinPMail, the Addressbook menu option becomes 
available at the right of the menu bar. This menu contains actions and commands specific to address 
books.

Searching: To to search for text in the address book, use the Find text and Find again options on the Edit 
menu.

The first options in the Addressbook menu control the sort order for the addressbook. Unless the address 
book is a system-wide entry, the sort order is remembered for each address book separately between 
sessions. The sort order which is currently active shows a checkmark in the menu.

The final three options on the menu control the way WinPMail will use addresses from the address book. 
Like the sort order, these settings are local to each non-system address book and are remembered between
sessions. The first two options in the group allow you to choose whether WinPMail should paste the alias 
or the actual e-mail address into messages when you drag and drop or press the Paste button. The default 
is to paste the alias. 

The last option on the menu allows you to tell WinPMail whether or not to resolve aliases in this address 
book. Alias resolution is the process of taking a name and finding the e-mail address which matches it 
from the address book at send time. The process of alias resolution can take quite a while if you have 
many or large address books, so you may want to disable it for some or all of your books. By default 
WinPMail resolves aliases in all address books.

Warning: if you turn off alias resolution for an address book then you can no longer use the Name field 
from entries in that address book as addresses.



The button panel

WinPMail's button panel is a set of tools which provides access to the most commonly-used parts of the 
program at the click of a button. Depending on the setting you specify in your Button Panel Preferences 
(see under the Tools | Options menu), the button panel can appear as either a fixed toolbar beneath the 
main menu (the default) or as a small floating window in either horizontal or vertical format.

WinPMail remembers the location and state (open or closed) of the button panel between sessions. You 
can also choose between having the button panel as a toolbar, or as a floating window in vertical or 
horizontal format using the option in your Preferences.

When the button panel is active as a toolbar, the buttons have the following functions:

Compose a new message
Read new mail
Open/manage mail folders
Open/manage address books
Open/manage distribution lists
Open the local user list
New mail filtering rules
Use the noticeboard system
Cut selection to the clipboard
Copy selection to clipboard
Paste the contents of the clipboard
Save or write to disk
Retrieve or import from disk
Print
Select font

The following three buttons will only appear if the built-in TCP/IP mail subsystem (using 
WINSOCK.DLL) is available for use:

Send all outgoing mail waiting in the mail queue
Check your POP3 host for new mail
Check for new mail and send queued mail in one action

When the button panel is active as a floating window, the buttons have the following functions:

allows you to start a new mail message

allows you to browse your new mail folder

allows you to browse other mail folders

allows you to manage your address books

allows you to manage your distribution lists





Options, or preferences

WinPMail allows you to customize many aspects of the way it works to suit your own tastes. The settings 
you make which control this are called your Preferences, or Options in some systems, and are stored in a 
file called PMAIL.INI in your new mail directory. The file is a plain text format and can be edited using 
any text editor (such as the DOS EDIT command, or the Windows Notepad editor).

Preferences fall into two classes - implicit preferences, such as the location of windows on the screen and 
the values you set in the controls in the message editor. WinPMail remembers implicit preferences 
without your personal intervention.

The other class of preferences are explicit preferences, or those where you actually instruct WinPMail to 
operate in a particular way. Explicit preferences are changed using the Options submenu of the Tools 
menu, which can also be selected at any time by pressing Shift+F10. The following settings pages are 
available there:

General settings

Advanced settings
Attachment viewers
Clickable links
Home mailbox location
Message editor Settings
Message reader settings
Network configuration
Signatures

The following option is only available if you are running on a Novell NetWare Local Area Network and 
your system supervisor has granted you access to it:

Extended features

The following option is only present if you are using Novells MHS Messaging system:

NetWare MHS settings



General settings

The following items can be changed in the General Settings dialog:

Personal name: WinPMail attaches whatever you enter here to your address when you send messages, 
making it easier for the recipient to identify who you are. You should make this entry simple and clear. 
Your personal name should consist only of letters and digits.

Open new mail at startup:    If you check this box WinPMail will automatically open your new mail folder
for you when you run it, provided it actually contains new mail. If you would prefer WinPMail to open 
your new mail folder at startup irrespective of whether or not it contains new mail, change the 
commandline you use to run WinPMail to

 WINPMAIL.EXE -Z 256

Preserve deleted messages until exit:    If you check this box, WinPMail will save any messages you 
delete in a special folder called Deleted Messages which will be cleared when you exit; this option can 
allow you to save messages deleted accidentally.

Ask for confirmation before deleting:    If you prefer that Pegasus Mail does not ask you to confirm that 
you really want to delete messages, uncheck this control. If you uncheck this control, you increase the 
risk of accidentally deleting messages you meant to keep, so we recommend you consider turning the 
Preserve deleted messages until exit option on.

Leave read new mail in newmail folder:  Usually when you close the new mail folder, Pegasus Mail 
moves all the messages you have read but left in that folder to your Main Folder. If you would prefer new 
mail to stay in your new mail folder until you explicitly move or delete it, check this control.

Ask for NetWare password at startup:    Check this and WinPMail will prompt you for your NetWare 
password when you run it. It will not run unless you enter the password correctly. This option adds 
security to your mail if you are away from your desk a lot. This control has no effect in non-NetWare 
environments and will not be available.

Encrypt copies to self of encrypted mail:    If you check this control, Pegasus Mail will encrypt copies to 
self of messages you send encrypted, using the same key as the message. If you subsequently open them 
in your Copy to self folder, you will need to know the password before you can read them. If this control 
is unchecked, then copies to self will always be stored as plain text whether or not the message itself is 
encrypted.

Offer advanced options for replies: WinPMail has an alternative reply dialog which allows you to select 
particular addresses from the original message for your reply. If you want to use the advanced reply 
dialog instead of the default simple reply dialog, check this box.

Save desktop state between sessions:  If this is checked, WinPMail will remember the folders, address 
books, distribution lists and other windows you have open at the end of a session, and will automatically 
reopen them at the start of the next session. Checking this control will also cause the Folder Manager 
window to remember which trays are open between sessions.

Auto-save:    If you enter a value (in minutes) here, Pegasus Mail will periodically save your messages as 
you compose them. Once the message is sent normally, the autosave file is deleted automatically, but if 
you have a system crash, you can recover the last saved version using the Open a saved message option 



on the File menu when you restart Pegasus Mail. Autosave files can be distinguished from other drafts in 
the list by the presence of the letters [ASV] at the start of the name.

Folder for copies to self:    If you click on the Select button, WinPMail will open the folder selector and 
allow to create or select a folderwhere your copies to self will be stored. By default the folder is called 
"Copies to self" with the DOS filename "copyself".

Default reply address:    If you want to specify an address which WinPMail will automatically copy to the 
reply-to field of every outgoing mail message, enter it here. There is usually no need to use this option -
you might use it if you routinely prefer to receive your mail on another system for instance.



Advanced settings

The advanced settings dialog lets you alter some of the more technical aspects of the way Pegasus Mail 
operates.

New mail folder poll time:  This option controls how frequently Pegasus Mail should scan your new mail 
folder for new mail while the newmail window is in the foreground. The default is to update the list every
three seconds, but this can generate a lot of Network traffic and can degrade your machine's performance, 
especially if you are connected to your server across a slow link. Setting this field to -1 will disable new 
mail polling altogether - the new mail window will only be updated when you explicitly choose "New 
mail" from the "File" menu, or click the "New mail" Icon in the toolbar.

Number of lines to probe for enclosures:    Pegasus Mail can always recognize attachments generated by 
other copies of Pegasus Mail, but attachments generated by other mail applications can be harder to find. 
When it opens your new mail folder, Pegasus Mail does a short scan into each message to see if it can 
find any obvious signs of attachments: the number of lines Pegasus Mail should scan into the message is 
controlled by this field. Note that clicking the Attachments button in the message reader always does a 
full scan of the message looking for attachments and will find any there may be -- this option really only 
affects the likelihood of the attachment marker being displayed in the folder window. Setting this field to 
a larger value will slow down the process of opening the new mail folder.

Organization:  This field is only used if you are not connected to a NetWare server; you can enter a name 
in this field and Pegasus Mail will place it in the "Organization" field of all mail sent locally and via 
gateways on your system.

SMTP time zone:  Again, this field is only meaningful if you are not connected to a NetWare server. You 
should enter your time zone in here expressed as a plus or minus offset from Greenwich Mean Time, and 
Pegasus Mail will then use it in the Date field of messages you send. Example: New Zealand is 11 hours 
ahead of GMT, so the proper value for this field would be +1100.

MIME character set:    This edit field controls the character set Pegasus Mail should use by default when 
writing MIME messages that contain international characters. Valid values are ISO8859-x, where x is a 
digit between 1 and 9. Pegasus Mail only has full formal support for ISO-8859-1, the other character sets 
being supported to varying levels. If you have added a comprehensive MIME character mapping table 
using an external resource file, you can also enter the name of that character set here. Entering an invalid 
character set name may have undefined consequences for people reading your mail    we strongly suggest 
that you only alter this control on advice from Pegasus Mail technical support.

Accept "confirm reading" requests: This option only applies when you are not connected to a NetWare 
server. It determines whether Pegasus Mail should send automatic answers indicating that you have read a
message when the "request confirmation of reading" flag is set in that message. If you uncheck it, Pegasus
Mail will never send confirmation of reading. If you are running on a NetWare LAN this option will be 
greyed and you cannot change it - instead, alter the option in your Extended features preferences.

Send enclosures instead of attachments:    When you send mail with attachments to Internet addresses, 
Pegasus Mail usually sends each attachment as a separate message. There are good historical reasons for 
this behaviour, but many users find it unintuitive.If you would prefer Pegasus Mail to encode attachments 
onto the end of your message and send only the single transmission, then check this control. Note: 
enclosures are harder for mail programs to find than attachments and can confuse some mail systems.

Allow 8-bit MIME encodings:    If you check this control, Pegasus Mail will generate MIME messages 



using the MIME "8BIT" transfer encoding whenever you include 8-bit data in your mail. 8-bit data is 
illegal in Internet mail, but is used in some countries. This is both a very technical, and potentially very 
dangerous option and should only be used if you know what you are doing. We recommend you do not 
check this control except on the advice of a properly qualified person.

Winsock loading options:  WINSOCK.DLL is a program which provides Pegasus Mail with access to 
TCP/IP networking services on your machine. By default, if Pegasus Mail can find a WINSOCK.DLL on 
your system, it will load it and make TCP/IP-based mail services available to you using it. If you do not 
use these features of Pegasus Mail, or if you see errors when Pegasus Mail tries to load the DLL, you can 
disable the automatic loading by clicking the Never button. If you are using WINSOCK across a slow 
dialup line, such as a SLIP link, you may have to check the Load only on demand button: this tells 
WinPMail to make TCP/IP based services available but only to load WINSOCK.DLL when it actually 
needs to use it, then unload it when it's finished. You might also want to use demand loading if your 
machine has only very limited memory. In normal use on an Ethernet LAN, however, you should check 
the Always button so that Pegasus Mail can get the highest performance from your TCP/IP network.

Telltale Window settings:    The telltale window appears when you minimize WinPMail on your desktop, 
and reports new mail in your new mail folder. If you would prefer that Pegasus Mail did not open the 
telltale window when minimized, uncheck the Enabled button. When the telltale window is disabled, it is 
up to you to check periodically and see if you have new mail. If you want the telltale window always to 
appear in front of all other applications on your system so you can always see your new mail count, check
the Always on top control.

The telltale window has three reporting modes - total, new, and summary. In total mode, it shows the total
number of messages in your new mail folder. In new mode, it shows only the number of messages which 
have arrived since WinPMail was minimized. In summary mode it shows a breakdown of the contents of 
your new mail folder. In all modes the count appears in red if new mail has arrived since WinPMail was 
minimized. You can change the telltale window mode by clicking on it. WinPMail remembers the telltale 
mode between sessions.

When the telltale window is visible on the screen, you can reactivate Pegasus Mail by clicking on the 
"Pegasus" icon in the telltale window, or by clicking on the minimized WinPMail icon itself.

Alert sounds    You can have Pegasus Mail play an alert sound when new mail arrives while it is 
minimized. Select the sound (any standard Windows .WAV file) using the Select sound button. You can 
test the sound using the Test button. Note that by default, WinPMail only plays the alert sound when mail 
arrives while the application is minimized on your desktop; if you would prefer it to play the alert sound 
any time new mail is detected, change the commandline you use to run WinPMail to WINPMAIL.EXE -
Z 512.



NetWare MHS preferences

If a version of Novell's MHS transport is installed on your system, then this option allows you to 
configure the way WinPMail will interact with MHS for you. In general, the options in this screen are 
quite complex and you should change them only if instructed to do so by your MHS administrator.

My NetWare MHS username:    This is the username by which MHS knows you. It may be the same as 
your NetWare username but need not be. If you are using an SMF-71 transport such as NetWare Global 
MHS, you can enter a full SMF-71 address (up to 128 characters long) in this field. You may need to enter
a complete address here if you are not a member of the default MHS workgroup.

Mailbox name:    This is the name of the directory in the MHS tree where your MHS new mail folder is 
located. If you are using MHS 1.5, it will usually be the first eight characters of your NetWare username 
(which is the default WinPMail uses) but it may be different, and is likely to be different if you are using 
an SMF-71 transport.

New mail folder:    This is the name of the folder in your new mail folder where WinPMail should expect 
to find your new mail. In technical terms, this field should contain the name of your preferred mailer 
which may or may not be PMail.

Check the MHS newmail folder:    By default, MHS creates a new mail directory for every user called 
MHS, and makes this directory the preferred mailbox for the user. Checking this control tells WinPMail to
check the MHS new mail folder as well as any other you name in the New mail folder field. Checking this
option is harmless at worst, although it may slow down checks for new mail a little bit.



Signatures

A signature is a small fragment of text which WinPMail will automatically add to the end of messages 
you send. You should usually put your name, address and phone/fax number in your signature, although 
some people like to place a witty saying or other text there as well. As a general rule, your signature 
should have no more than 7 lines maximum.

WinPMail supports separate signatures for each type of message you can send - Local, Internet and 
MHS.Note that it bases its selection of signature on the transport mechanism, so if you send a message to 
a user on your file server but do so via an Internet transport such as Mercury or Charon, your Internet 
signature will be attached to the message.

Variable signatures:    Pegasus Mail can place a piece of text selected at random from a list you provide in
your signature -- for more information on preparing a variable signature, examine the sample quotes file 
RQUOTES.R in the RESOURCE\ subdirectory of the directory where you installed WinPMail. To flag the
location in your signature where you want the variable text to be placed, use the special characters ~!. Be 
careful when using variable signatures -- people's tastes differ hugely all around the world, and something
which seems witty to you may be offensive to other people.



Home mailbox location

Your home mailbox is where all your mail folders, distribution lists, address books and other PMail 
related files (except unread new mail) are stored. By default, it is located in a special directory on the file 
server, but you can specify an alternative location for it using this option.

Note: before using this option, make sure that all windows in WinPMail are closed except the button 
panel (which can also be closed but does not have to be).

You may want to change your home mailbox location if you have limited space on the file server, if you 
are concerned about the privacy of your mail, or for other reasons. You can also have more than one 
mailbox and change between them using this dialog - you might want to do this if you received mail at 
your address for more than one person or organization.

To change your home mailbox location, type in the new path in either DOS or NetWare format. If you 
want to change the location but leave all your mail files where they are, make sure that the move mailbox 
contents to new location button is not checked (this is how you would implement more than one mailbox 
as described above). If you have moved your home mailbox but want to revert to the original location on 
the file server, press the Default button.

If you have chosen to move the contents of your home mailbox, WinPMail will do so as soon as you click
OK.



Extended features

Extended features are special Pegasus Mail features which you only have if the system administrator has 
explicitly granted them to you. If you have been granted access to extended features, then the Extended 
features menu option in the Preferences sub-menu will be available, otherwise it will be grey and you 
cannot select it. Choosing this option opens a dialog which allows you to change the following:

Autoforwarding: Pegasus Mail supports autoforwarding, or the redirection of your mail to another 
account. You can autoforward either mail delivered to you from local addresses, mail received from the 
Charon or Mercury Internet gateway, both or neither. It is possible to forward one type of mail but not the 
other. To set autoforwarding, place the forwarding address in either or both of the available autoforward 
fields. You can forward local mail to any address WinPMail can understand including NetWare groups 
and distribution lists. Internet mail can only be forwarded to simple local addresses or to Internet 
addresses. Mail arriving via NetWare MHS cannot be autoforwarded.

Deliver mail even if autoforwarding: check this box if you want Pegasus Mail to leave a copy of mail as 
well as forwarding it when you have autoforwarding addresses set. This option has no effect if you are not
forwarding your mail.

Allow 'confirmation of reading' requests. If you uncheck this box, then WinPMail will not return 
confirmation that you have read messages when it is requested. Local users will be told the moment they 
send the message that no confirmation will be supplied, but Internet and MHS mail will receive no such 
notification.

Advise of new mail via broadcasts: When this box is checked, Pegasus Mail will send a NetWare-style 
broadcast message to indicate that a new mail message has arrived. If you find the broadcast messages 
annoying but do not want to use the NetWare CASTOFF command to disable them, uncheck this box..

Disable mail delivery to this address: If checked, it will not be possible to send mail to this address.



Message editor settings

This page allows you to change the initial settings for mail messages you create.

Settings used when encrypting messages

Use MIME features    MIME is an Internet standard for handling mail messages. In general, we strongly 
recommend that you use Pegasus Mails MIME features unless you are corresponding with someone using
a mail system that does not understand or follow the MIME standard. This control determines the default 
state of MIME support in your mail messages - whichever value you select is what Pegasus Mail will use 
each time you start a new message. You can enable or disable MIME support on a message by message 
basis using the control in the Special view of the message editor. When MIME support is turned on, 
Pegasus Mail will use MIME encodings for all attachments, and will use the proper MIME 
transformations to preserve special and accented characters in your messages. Pegasus Mail always 
handles mail you receive that uses MIME formats correctly whether or not this control is turned on.

Confirm reading, confirm delivery, copy to self    These sets of controls let you set the default value for the
controls they match in the message editor. The On and Off settings are self-explanatory; if Use last setting
is selected, then Pegasus Mail will remember from message to message the last setting you used and will 
use that. This is also called sticky setting throughout this help file and is the default setting for all three 
controls.

Message width    This field allows you to specify the average length of a line of text in your message. 
WinPMail will adjust the margin of the message editor so that approximately the number of characters 
you specify will fit on a line. You cannot enter a width wider than the current width of the editing 
window.

Average tab width    By default, WinPMail obeys the standard Windows convention that the <Tab> key 
moves from field to field in a dialog. If you enter a width in this field, however, WinPMail will insert the 
<Tab> characters in the message instead. You can only change the tab width if tabs were enabled when 
you started the message. The width you enter is an average based on the average width of characters in 
the current font; it will only be exact if you use a monospace font such as Courier.

Automatically check spelling before sending message    If you check this control, Pegasus Mail will 
automatically run its spelling checker over every message you send as soon as you click the Send button. 
You can check your spelling manually at any time by selecting Check spelling from the Tools menu. 
Pegasus Mail has a 65,000 word English dictionary and allows you to save up to 5,000 words in your own
personal user dictionary. Please note that Pegasus Mail originates from a Commonwealth country (New 
Zealand) and thus uses true English spellings in its dictionary, so words like color will be flagged as 
incorrect. At the time of writing this help file, we are attempting to put together a US English dictionary 
for our North American users. If such a dictionary becomes available, it will be announced on the various 
Pegasus Mail mailing lists (see the Pegasus Mail online guide, which should have been installed when 
you installed Pegasus Mail, for more details on subscribing to the various mailing lists).

Ask whether or not to make a copy to self    If checked, Pegasus Mail will ignore the copyself control in 
the message editor and when you click the Send button will ask you whether or not you want to keep a 
copy of the message.

If making a copy to self, ask which folder to put it in    If checked and you indicate you want to make a 
copy to self, Pegasus Mail will open the folder selector and ask you to select the folder into which the 
copy should be placed. If unchecked, Pegasus Mail will use the copy to self folder defined in your 



General settings options page.



Settings used when encrypting messages

Pegasus Mail has a built-in encryption module that you can use to scramble your mail messages, to keep 
them from prying eyes. It also supports plug-in encryption modules for systems such as Phil Zimmermans
PGP (Pretty Good Privacy). You can alter some of the settings Pegasus Mail will use when you choose to 
encrypt your messages using the group of controls at the foot of the Message editor settings dialog.

Default encryption method    If you have installed a third-party encryption module on your system, it will 
appear in this list: by selecting it here, you can tell Pegasus Mail that this is the encryption module you 
would like to use by default. Note that this does not mean that all your mail will be encrypted    simply 
that if you choose to encrypt a message, the encryptor you have chosen will be preselected in the 
encryption dialog, which can save some time if you encrypt messages often.

Default password    Some encryption modules, for instance John Navass PGP-JN implementation, may 
require a passphrase in order to perform certain operations (PGP-JN, for example, needs the passphrase to
access your PGP keyring when signing or encrypting messages). If your encryptor needs a passphrase, 
you can if you wish enter it here, which will save you from having to type it in every time you want to 
encrypt or sign a message. If you enter your passphrase here, it will be stored in your INI file in an 
encrypted form.

WARNING!!    Setting your passphrase in this control is a security risk    you should not do it if your 
machine may be accessed by unauthorised users. This facility is provided for the convenience of users 
with low security requirements or whose systems are located in secure areas.

Ask at startup    If you do not want to enter your passphrase by default but also dont want to have to type 
it repeatedly, then you can check this control and WinPMail will ask you to enter your passphrase at 
startup. This is a reasonable compromise between security and convenience, but is still not 100% secure.

Attach a digital signature if the encryptor supports it    A digital signature is a special form of encryption 
that authenticates a mail message as being from you and as being unaltered, while still allowing the 
recipient to read the message normally. Digital signatures are based on complex mathematics and offer 
very reliable proof of the authenticity of a mail message. If you have installed an encryption module, such
as PGP-JN, that supports digital signing, you can check this control to have Pegasus Mail automatically 
generate a signature for every message you send by default. Note that in most cases if you check this 
control, you will also need to provide your passphrase by one means or another. Checking this control 
will also increase the size of each message you send and may introduce a delay in the sending process.



Message reader settings

The Message reader settings page of the options and preferences dialog allows you to control the way 
Pegasus Mail displays messages in the message reader.

Show quoted text in    It is a common Internet convention to include part of the mail message to which you
are replying in your reply, marked with the character >    to show that it is being quoted. When you are 
reading messages, Pegasus Mail can display parts of the message marked this way in a different colour, 
which can make it much easier to follow the flow of the conversation. Select the colour you would like 
Pegasus Mails reader to use for quoted text from the drop-down list.

Italics    If you check this control, Pegasus Mail will also show quoted text using an italic typeface. This 
can further increase the ease of reading replies.

Always save the last window size used  Pegasus Mail normally uses a default size for message reader 
windows - you can adjust that default size by setting a reader window to the size you would like then 
choosing Save window size from the Reader menu. All subsequent message reader windows will open at 
that size. If you would prefer that Pegasus Mail always used the size of the last message reader window 
you opened instead, check this control.

When the current message is moved or deleted    These controls determine how the message reader will 
react when you move or delete the message you are reading.



Reading mail

To read a message in a folder, either double-click on it or select it and press the Open button.

While you are reading a message, a button bar with most of the options available in the folder window 
appears. There is also a Print button, which has the same effect as choosing Print from the File menu, and
a pair of buttons marked Next and Prev. The Next button replaces the message in the reader window with 
the next message from the folder, while the Prev button replaces the message with the one before it in the 
folder. If you hold down the Shift key while you press Next or Prev, the message you are leaving will be 
marked in the folder selector before the new one is loaded. If you hold down the Ctrl key when you click 
Next, Prev, Move, or Delete, the next or previous unread message will be loaded instead of simply the 
next message.

The Copy command on the Edit menu will copy lines from the message reader for pasting elsewhere. By 
using the Ctrl key while selecting lines you can select separate groups of lines simultaneously in the 
message, and copy them all with one command. Current versions of WinPMail can only copy whole lines 
from messages -- you cannot copy just part of a line.

Options specific to the message reader appear in the Reader menu.



The Reader menu

While reading mail, the Reader menu appears at the right of the menu bar. The menu offers options 
specific to the message reader: Note that you can alter certain aspects of the message readers behaviour 
using the Message reader settings page of the Options dialog on the Tools menu.

Format options:    Allows you to choose the colour and format the message reader should use to display 
text in messages that has been quoted from earlier messages, and also contains an option to allow you to 
force the window size of the message reader to be saved automatically.

Save window size:    When you choose this option, WinPMail will save the current size of the message 
reader window to your preferences. All future message reader windows you open will open at this size. 
You cannot save the location of a message reader window because doing so would result in messages 
overlapping onscreen and therefore being difficult to select. If you would like WinPMail always to save 
the last size you used for a message reader window, use the Format options menu entry (see above).

Show all headers:    By default, WinPMail displays only headers in the message which are meaningful to 
the reader, suppressing all others. If you need to see the message exactly as it was delivered, with its 
headers intact, select this option. Note: Unlike the DOS version of Pegasus Mail, where the show all 
headers option is global and affects all subsequent messages, WinPMail only applies this option to the 
current message. You can trigger and reset this option from the keyboard by pressing Ctrl+H

Toggle monospaced view    Most fonts in Windows are proportionally-spaced -- that is, an 'I' character 
takes up less space on a line than an 'm' character. If you receive a message containing a table or other 
information laid out in a columnar manner and your normal reader font is proportionally spaced, the 
columns in the table will not line up correctly. Selecting this command temporarily switches the message 
reader into a monospaced font, where all characters are the same width. This will allow you to see the 
tabulation correctly. Selecting this command again will switch you back to your regular view of the 
message. You can also toggle this mode by pressing the F12 key on your keyboard.

Extract message to file:    If you want to make a copy of this message in a DOS text file, perhaps for 
inclusion in another program, then select this option. You will be prompted for a filename - when you 
click OK, WinPMail will extract the contents of the message to the file. You can also perform this action 
by clicking the Save to disk button on the button panel.

Font...: Use this option to change the font you use to view messages. This change is global, and affects all
messages already open and subsequently opened in WinPMail. You can also click the Font button on the 
button panel to set the message reader's font.



Headers are the special set of lines at the start of a mail message which contain addressing and other 
machine-readable information about the message. Headers are rigidly formatted and vary widely from 
system to system; many headers in a message are only of interest to the mail transport system and are 
meaningless to a human reader, while others, such as the Subject and From fields carry information which
the reader needs to know. Pegasus Mail usually tries to present you with only those headers which may be
meaningful to you.



The MHS Directory Service

If your system has an MHS SMF-71 message transport such as Novell's NetWare Global MHS, then the 
directory service provided by that system (called the Extract File) is available to you from within 
WinPMail. To open the MHS Directory Service, choose the entry on the Addresses Menu.

The MHS directory service list behaves like a read-only address book: you can double-click on an entry 
to start a new message using the entry as an address, you can drag addresses from the list window to any 
address field, or you can click on the Paste button to paste the selected addresses into the last address 
field you were using.

You can also speed search through the list by typing the first few characters of the name you are looking 
for.

For technical reasons, you should close the extract file window as soon as you can after using it, since 
NetWare MHS may not be able to update the list while you have the file open.



Built-in TCP/IP network mail services

WinPMail has built-in support for mail services accessed using TCP/IP (Internet) network protocols 
called POP3 (Post Office Protocol) and SMTP (Simple Mail Transfer Protocol). In order to access these 
services, you must have a TCP/IP network transport interface with a special Windows DLL called 
WINSOCK.DLL installed on your system.

POP3 services allow you to retrieve new mail held for you on another machine (usually a unix machine or
a NetWare file server).

SMTP services allow you to send mail to the Internet; WinPMail implements SMTP mail using a relay 
service - that is, it asks a complete SMTP implementation (usually running on a unix machine) to send the
mail on its behalf.

Configuring Pegasus Mail's TCP/IP mail services
Troubleshooting
Accessing multiple remote mailboxes - MultiPOP



Configuring WinPMail for WinSock-based mail services

In order to use Pegasus Mail's built-in support for TCP/IP mail, you must have a properly-installed 
Windows Sockets implementation installed on your system, and its WINSOCK.DLL file must be on the 
path, in the \WINDOWS directory, or in the \WINDOWS\SYSTEM directory. You can force WinPMail to
load a particular WINSOCK.DLL file using commandline options.

By default, when Pegasus Mail detects that you have a valid WINSOCK.DLL on your system, it will 
enable the built-in TCP/IP services by setting the WinSock loading option in your Advanced Settings 
preferences to On demand. This means that WinPMail will only load WINSOCK.DLL when it actually 
needs to access its services. When you are using a SLIP or PPP link to connect to the Internet, most 
WINSOCK.DLL versions will dial as soon as they are loaded, so the On demand setting allows you to 
minimize your connect time when checking for mail. If you are connected to a fast local area network, 
however, you should probably consider setting the Winsock loading flag to Always, for performance 
reasons.

If you have a valid WinSock implementation installed on your system, six extra options will appear on 
your File menu. The first option, Network Configuration, allows you to configure the way WinPMail's 
built-in TCP/IP mail services work for you.

Entering the essential information
Setting the TCP/IP timeout field
Using the built-in TCP/IP mail services
Accessing multiple remote mailboxes - MultiPOP

Advanced configuration options

Overview of configuring for receiving mail via POP3
Overview of configuring for sending mail via SMTP



Accessing multiple remote mailboxes with MultiPOP

From time to time you may need to access more than one remote POP3 mailbox from a single copy of 
Pegasus Mail - this usually happens when you have accounts with more than one Internet Service 
Provider, or when you are looking after someone else's mailbox for them in their absence.

Pegasus Mail is shipped with an Extension called MultiPOP that allows you to access as many POP3 
mailboxes as you wish and offers more scheduling flexibility than the standard WinPMail built-in POP3 
services. If you did a standard install of Pegasus Mail then you should find MultiPOP on Pegasus Mail's 
Extensions menu. MultiPOP has its own online help.



Pegasus Mail Extensions:    An extension is a program that can be loaded into Pegasus Mail to 
enhance it in some way, either by adding new functionality or by changing the way an existing feature 
operates. In other programs, these are also called Plug-ins and Snap-ins. Pegasus Mail is shipped with a 
number of extensions written by Pegasus Mail's author, but extensions can also be written and supplied by
other developers.

Pegasus Mail provides an extremely rich range of functions and options for extension developers and the 
entire interface is publicly documented-- if you are interested in developing extensions for Pegasus Mail, 
we suggest you obtain the file WPMFORMS.ZIP from the site where you obtained Pegasus Mail - this 
contains all the information you need to begin work.



Entering the essential information

Before Pegasus Mail can send or receive mail on your behalf using its built-in TCP/IP mail routines, there
is a certain amount of information you must give it, which should be entered in the dialog you see when 
you choose Network Configuration from the File menu. This information should have been provided to 
you by your Internet Service Provider or Computing Centre -- Pegasus Mail cannot use any kind of 
default values for any of the fields in this screen, unlike the options in the Advanced Configuration 
Options screen, which all have reasonable default values.

The information you must provide before Pegasus Mail can operate is as follows:

POP3 host  The name of the machine from which Pegasus Mail should retrieve your new mail. The 
format of the address you provide here depends on your WinSock implementation: many will allow you 
to enter a normal internet name (for example, parnassus.pmail.gen.nz), but some may require that you 
enter the address in dotted notation (for example, 192.156.225.2). Consult your system manager or 
WinSock manual if you are unsure which form to use.

Username    The name of the account on the machine under which mail is being held for you. WinPMail 
logs into the host using this account name and retrieves any mail waiting there. WinPMail only wants 
your username in this field, not your address - if what you have entered here contains an '@' symbol, then 
it is probably incorrect.

Password    The password for the account on the host. The password is not displayed on the screen and is 
stored in an encrypted format in your configuration file.

SMTP host    Enter here the name of a machine which can process outgoing mail on your behalf. This is 
usually the same machine you entered as your POP3 mail host, and the address is subject to the same 
restrictions and rules described there. WinPMail asks the relay machine to send outgoing mail on your 
behalf, so the machine you name must be running an SMTP server; your system manager or service 
provider will be able to tell you which machine or address to use for this field.



Advanced Configuration for WinSock Mail

When you click the Advanced Configuration Options button in the Network Configuration dialog, you 
will be presented with a screen where you can tailor the more specialised or technical options controlling 
the way Pegasus Mail retrieves and sends your mail.

Many of the options in this screen are quite technical and they may be confusing or obscure to people 
who are not experienced with them. While we would like to reduce the jargon content of this screen, the 
fact remains that Internet electronic mail is inherently very rich in capabilities, and much of the apparent 
complexity of this screen cannot really be avoided. If you are unfamiliar with the intricacies of Internet 
Mail, we recommend that you do not adjust any of the values in this screen except perhaps the TCP/IP 
timeout value without first consulting someone more experienced who can advise you.

TCP/IP timeout settings - click here for more information.

Options for outgoing (SMTP) mail:

From field  WinPMail allows you to specify your own from field in outgoing messages. This facility is 
provided only to allow you to conform with local addressing schemes or requirements and should not be 
used capriciously. In order to prevent message forgery using this feature, WinPMail will only send mail if 
you have entered a valid username and password in the POP3 section of the configuration dialog, and will
check the validity of these details when sending. The valid POP3 address is written into a field in the 
message for security reasons.

Use this "from" field to form the SMTP envelope. An Internet Mail message consists of two sections - the 
message and the envelope. The envelope is a kind of "wrapper" of delivery information that is passed 
from SMTP host to SMTP host, and includes information about the sender and recipients of the message 
in transit. You will usually never see the envelope, as it is discarded once the message is actually 
delivered. The only remnant of the envelope in your message is a special field amongst the message 
headers called Return-path, which contains the authenticated address of the original sender of the 
message. The Return-path information is usually only used by SMTP servers to handle errors, but 
unfortunately there are some mail systems on the Internet that ignore your "From" field address and 
instead send replies to whatever value is stored in the Return-path header. By default, Pegasus Mail forms
the return-path header from your POP3 username and server information, since it knows this address is 
valid. In some cases, though, your POP3 address information may not be valid in the outside world - it 
might only be valid when you contact your Internet Service Provider directly. In cases like this, the small 
group of aberrant mail systems on the Internet may end up trying to reply to you using an address that is 
not valid. Checking this control tells Pegasus Mail to form your Return-path headers using the 
information you have supplied rather than the authenticated POP3 server information. Doing this will on 
one hand probably fix the problems users on the aberrant systems are having sending replies to you, but 
on the other hand may create local delivery problems. In short, if you have someone report that they 
cannot reply to your address even though you have a valid address in the "from field" section of this 
dialog, try checking this control.

Send mail at once without placing in queue    If you check this, WinPMail will send your mail messages to
the relay host as soon as you click the Send button in the message editor. If you leave the box unchecked, 
WinPMail will queue your messages, and will only send them to the relay host when you explicitly 
choose Send all queued mail from the File menu. If you are using a slow TCP/IP link, you should 
probably leave this box unchecked.

Use in preference to LAN mailer for Internet mail    This option is only meaningful when you are running 



WinPMail on a NetWare system which is also served by either the Mercury SMTP transport or the Charon
Internet mail gateway. Checking this control tells WinPMail to use its own built-in mail delivery routines 
instead of passing your outgoing mail to Mercury or Charon for processing. If you leave this box 
unchecked, then WinPMail will always use Mercury or Charon in preference to its own SMTP delivery 
routines if either is available on the NetWare system to which you are connected. The setting of this 
control is ignored when you run WinPMail in a non-NetWare environment.

Use for all outgoing mail, regardless of address:    Usually when you enter an address such as "DAVID", 
which has no domain portion, Pegasus Mail regards it as a local address and attempts to deliver it to the 
user based on the assumption that he can be found on the machine you are using. If you are the only 
person who uses your computer, however, then there will be no other users on your system and this 
assumption will not be valid. Checking this control tells Pegasus Mail to pass all mail to the remote host 
for processing and not to presume that any addresses are local to your machine. You should only check 
this control if you are the only person who uses your machine.

Send any mail in the queue during idle checks:    If you check this control, WinPMail will send any 
messages waiting in your mail queue when it does an idle check to see if you have new POP3 mail. The 
frequency of these checks is determined by the setting of the Poll new mail after x secs idle field of the 
POP3 configuration section of the Network configuration dialog

Options for incoming (POP3) mail

Connect to POP3 server on TCP port    The TCP/IP port on which the server listens for your connections. 
The default for this field is 110, which is the port defined by the POP3 standard. On rare occasions, your 
POP3 server may listen for connections on a different port number, in which case you would enter that 
port number here. You should only change this value if advised to do so by your service provider, network 
administrator, or by Pegasus Mail technical support.

Do not download mail larger than x KB If you are connected to the mail host by a slow TCP/IP link (such
as a SLIP link) then downloading large messages can be very time consuming. If you enter a value in this 
field, WinPMail will not attempt to retrieve any mail larger than the size you specify (in kilobytes) - it 
will be left untouched on the host. A value of 0 in this field means no limit - WinPMail will download all 
mail.

Check for new POP3 mail every x secs idle    This option controls whether or not WinPMail should poll 
your POP3 host for new mail automatically, and if so, how often. Enter here a number of seconds between
poll cycles (WinPMail is accurate to the nearest three seconds), and then if you leave WinPMail idle (no 
keystrokes or mouse presses) for this length of time it will automatically check for new mail. A value of 
zero means that WinPMail should never poll the POP3 host automatically    you will have to initiate the 
check yourself by choosing "check host for new mail" from the File menu.

Count new messages when polling but don't download    If this control is checked and you have set an idle
poll cycle (see the last entry) then WinPMail will simply check the number of new mail messages on each
idle check and report that number on the status bar. If this control is unchecked, WinPMail will 
automatically download any new mail it finds on the host on each idle check. On slow links, checking this
control can result in a lower performance demand on your machine.

Allow checks when WinPMail is minimized  By default, Pegasus Mail does not check the remote host for 
new mail periodically when it is minimized on your desktop, in order to reduce loading on your system 
and to eliminate the "jerkiness" the extra activity produces. With many versions of WINSOCK.DLL, 
however, the loading incurred by background checking is quite light, so if you would like Pegasus Mail to



check while in the background then click this control.

Delete mail from host once successfully retrieved    If you check this box, WinPMail will delete the host's 
copy of each mail message it successfully downloads, which will prevent it from being presented to you 
again the next time you retrieve mail. Leaving this box unchecked tells WinPMail to leave the mail on the
host even if successfully downloaded. Mail left on the server will be retrieved every time you download 
mail.

Check whenever the new mail is opened    If you check this box, WinPMail will check the host for new 
mail every time you open the new mail folder or click the New Mail button in the button panel. If you 
leave this button unchecked, then WinPMail will only check for new mail when you explicitly choose 
Check host for new mail from the File menu.

Download only unread mail    The usual practice when retrieving mail from a POP3 host is to delete it 
from the host when it is successfully downloaded. If you do not delete it, you would normally expect to 
see it again the next time you download mail from the host. WinPMail incorporates a powerful and 
complicated facility which allows you to leave mail on the POP3 host without deleting it, but only 
download mail you haven't already seen. Because the POP3 protocol does not actually provide this 
facility, there are some limitations on this command, the most specific being that if you run WinPMail on 
more than one machine, each one will have a separate list of what you have already seen; so, if you 
download mail using one machine then access your account later from a different machine, you will 
probably get the mail you downloaded the first time again, where downloading the mail on the same 
machine you originally used would only show mail which had arrived since the last time you accessed 
your account. Check this control to instruct WinPMail to attempt to download only mail you have not 
read. The effect of this control is probably meaningless if you do not also uncheck the "Delete retrieved 
mail on host" control. Using this feature can significantly increase the time it takes for WinPMail to 
retrieve your new mail.



TCP/IP timeout settings

The TCP/IP timeout value setting in the Advanced Configuration Options screen of the Network 
Configuration dialog controls how long Pegasus Mail should wait for responses on your network before 
assuming that a problem has occurred. On fast networks such as Ethernet, you should set this to a 
relatively small value, such as 15 seconds. On slow links such as SLIP or PPP, however, considerably 
longer values may be appropriate - for example, 120 seconds or even more. If you find that Pegasus Mail 
is frequently reporting network errors, try increasing this value to a larger setting.

Because of the way Pegasus Mail's TCP/IP module works, you can run into problems if you exit from 
WinPMail while a TCP/IP operation is in progress. Because of this, you should experiment with the 
timeout value, until you find the lowest value that gives you reliable connectivity. Avoid using a timeout 
value which is higher than it needs to be. Our recommendations are as follows

On a fast local area network:    15 seconds
Using a reliable PPP link, or 28.8K modems    30 seconds
Using a SLIP link or 14K4 modems    60 seconds
If your link occasionally loses packets    add 60 seconds



Configuring WinPMail to receive mail via POP3

This section gives a general overview of all the settings available in the Network Configuration dialog 
and Advanced Configuration Options dialog that control the way Pegasus Mail retrieves mail for you.

POP3 is the protocol WinPMail uses to download your new mail from remote mailbox via TCP/IP. You 
control the way Pegasus Mail interacts with your remote mailbox using the options on the right-hand side 
of the Network configuration dialog.

POP3 host  The name of the machine from which Pegasus Mail should retrieve your new mail. The 
format of the address you provide here depends on your WinSock implementation: many will allow you 
to enter a normal internet name (for example, parnassus.pmail.gen.nz), but some may require that you 
enter the address in dotted notation (for example, 192.156.225.2). Consult your system manager or 
WinSock manual if you are unsure which form to use.

Connect to POP3 server on TCP port    The TCP/IP port on which the server listens for your connections. 
The default for this field is 110, which is the port defined by the POP3 standard. On rare occasions, your 
POP3 server may listen for connections on a different port number, in which case you would enter that 
port number here. You should only change this value if advised to do so by your service provider, network 
administrator, or by Pegasus Mail technical support.

Username    The name of the account on the machine under which mail is being held for you. WinPMail 
logs into the host using this account name and retrieves any mail waiting there. WinPMail only wants 
your username in this field, not your address - if what you have entered here contains an '@' symbol, then 
it is probably incorrect.

Password    The password for the account on the host. The password is not displayed on the screen and is 
stored in an encrypted format in your configuration file.

Do not download mail larger than x KB If you are connected to the mail host by a slow TCP/IP link (such
as a SLIP link) then downloading large messages can be very time consuming. If you enter a value in this 
field, WinPMail will not attempt to retrieve any mail larger than the size you specify (in kilobytes) - it 
will be left untouched on the host. A value of 0 in this field means no limit - WinPMail will download all 
mail.

Check for new POP3 mail every x secs idle    This option controls whether or not WinPMail should poll 
your POP3 host for new mail automatically, and if so, how often. Enter here a number of seconds between
poll cycles (WinPMail is accurate to the nearest three seconds), and then if you leave WinPMail idle (no 
keystrokes or mouse presses) for this length of time it will automatically check for new mail. A value of 
zero means that WinPMail should never poll the POP3 host automatically    you will have to initiate the 
check yourself by choosing "check host for new mail" from the File menu.

Count new messages when polling but don't download    If this control is checked and you have set an idle
poll cycle (see the last entry) then WinPMail will simply check the number of new mail messages on each
idle check and report that number on the status bar. If this control is unchecked, WinPMail will 
automatically download any new mail it finds on the host on each idle check. On slow links, checking this
control can result in a lower performance demand on your machine.

Allow checks when WinPMail is minimized  By default, Pegasus Mail does not check the remote host for 
new mail periodically when it is minimized on your desktop, in order to reduce loading on your system 
and to eliminate the "jerkiness" the extra activity produces. With many versions of WINSOCK.DLL, 



however, the loading incurred by background checking is quite light, so if you would like Pegasus Mail to
check while in the background then click this control.

Delete mail from host once successfully retrieved    If you check this box, WinPMail will delete the host's 
copy of each mail message it successfully downloads, which will prevent it from being presented to you 
again the next time you retrieve mail. Leaving this box unchecked tells WinPMail to leave the mail on the
host even if successfully downloaded. Mail left on the server will be retrieved every time you download 
mail.

Check whenever the new mail is opened    If you check this box, WinPMail will check the host for new 
mail every time you open the new mail folder or click the New Mail button in the button panel. If you 
leave this button unchecked, then WinPMail will only check for new mail when you explicitly choose 
Check host for new mail from the File menu.

Download only unread mail    The usual practice when retrieving mail from a POP3 host is to delete it 
from the host when it is successfully downloaded. If you do not delete it, you would normally expect to 
see it again the next time you download mail from the host. WinPMail incorporates a powerful and 
complicated facility which allows you to leave mail on the POP3 host without deleting it, but only 
download mail you haven't already seen. Because the POP3 protocol does not actually provide this 
facility, there are some limitations on this command, the most specific being that if you run WinPMail on 
more than one machine, each one will have a separate list of what you have already seen; so, if you 
download mail using one machine then access your account later from a different machine, you will 
probably get the mail you downloaded the first time again, where downloading the mail on the same 
machine you originally used would only show mail which had arrived since the last time you accessed 
your account. Check this control to instruct WinPMail to attempt to download only mail you have not 
read. The effect of this control is probably meaningless if you do not also uncheck the "Delete retrieved 
mail on host" control. Using this feature can significantly increase the time it takes for WinPMail to 
retrieve your new mail.



Configuring WinPMail to send mail via SMTP

This section gives a general overview of all the settings available in the Network Configuration dialog 
and Advanced Configuration Options dialog that control the way Pegasus Mail sends mail for you.

SMTP is the protocol WinPMail uses to send mail via TCP/IP. You control the way Pegasus Mail uses the 
SMTP protocol using the options on the left hand side of the Network configuration dialog.

SMTP host    Enter here the name of a machine which can process outgoing mail on your behalf. This is 
usually the same machine you entered as your POP3 mail host, and the address is subject to the same 
restrictions and rules described there. WinPMail asks the relay machine to send outgoing mail on your 
behalf, so the machine you name must be running an SMTP server; your system manager or service 
provider will be able to tell you which machine or address to use for this field.

From field  WinPMail allows you to specify your own from field in outgoing messages. This facility is 
provided only to allow you to conform with local addressing schemes or requirements and should not be 
used capriciously. In order to prevent message forgery using this feature, WinPMail will only send mail if 
you have entered a valid username and password in the POP3 section of the configuration dialog, and will
check the validity of these details when sending. The valid POP3 address is written into a field in the 
message for security reasons.

Use this "from" field to form the SMTP envelope. An Internet Mail message consists of two sections - the 
message and the envelope. The envelope is a kind of "wrapper" of delivery information that is passed 
from SMTP host to SMTP host, and includes information about the sender and recipients of the message 
in transit. You will usually never see the envelope, as it is discarded once the message is actually 
delivered. The only remnant of the envelope in your message is a special field amongst the message 
headers called Return-path, which contains the authenticated address of the original sender of the 
message. The Return-path information is usually only used by SMTP servers to handle errors, but 
unfortunately there are some mail systems on the Internet that ignore your "From" field address and 
instead send replies to whatever value is stored in the Return-path header. By default, Pegasus Mail forms
the return-path header from your POP3 username and server information, since it knows this address is 
valid. In some cases, though, your POP3 address information may not be valid in the outside world - it 
might only be valid when you contact your Internet Service Provider directly. In cases like this, the small 
group of aberrant mail systems on the Internet may end up trying to reply to you using an address that is 
not valid. Checking this control tells Pegasus Mail to form your Return-path headers using the 
information you have supplied rather than the authenticated POP3 server information. Doing this will on 
one hand probably fix the problems users on the aberrant systems are having sending replies to you, but 
on the other hand may create local delivery problems. In short, if you have someone report that they 
cannot reply to your address even though you have a valid address in the "from field" section of this 
dialog, try checking this control.

Send mail at once without placing in queue    If you check this, WinPMail will send your mail messages to
the relay host as soon as you click the Send button in the message editor. If you leave the box unchecked, 
WinPMail will queue your messages, and will only send them to the relay host when you explicitly 
choose Send all queued mail from the File menu. If you are using a slow TCP/IP link, you should 
probably leave this box unchecked.

Use in preference to LAN mailer for Internet mail    This option is only meaningful when you are running 
WinPMail on a NetWare system which is also served by either the Mercury SMTP transport or the Charon
Internet mail gateway. Checking this control tells WinPMail to use its own built-in mail delivery routines 
instead of passing your outgoing mail to Mercury or Charon for processing. If you leave this box 



unchecked, then WinPMail will always use Mercury or Charon in preference to its own SMTP delivery 
routines if either is available on the NetWare system to which you are connected. The setting of this 
control is ignored when you run WinPMail in a non-NetWare environment.

Use for all outgoing mail, regardless of address:    Usually when you enter an address such as "DAVID", 
which has no domain portion, Pegasus Mail regards it as a local address and attempts to deliver it to the 
user based on the assumption that he can be found on the machine you are using. If you are the only 
person who uses your computer, however, then there will be no other users on your system and this 
assumption will not be valid. Checking this control tells Pegasus Mail to pass all mail to the remote host 
for processing and not to presume that any addresses are local to your machine. You should only check 
this control if you are the only person who uses your machine.

Send any mail in the queue during idle checks:    If you check this control, WinPMail will send any 
messages waiting in your mail queue when it does an idle check to see if you have new POP3 mail. The 
frequency of these checks is determined by the setting of the Check for new POP3 mail every x secs idle 
field of the POP3 configuration section of the Advanced options network configuration dialog



Using WinPMail's built-in TCP/IP mail services

Once you have configured WinPMail correctly, you can use the options on the File menu and the three 
special buttons on the button panel to access and send your mail.

 , or Send all queued mail on the File menu: Tells WinPMail to process all mail currently in your 
outgoing mail queue and send it to your relay host using the SMTP protocol. If you have checked the 
control labelled Send queue during idle checks in your Network configuration dialog then any mail in 
your queue will also be sent any time WinPMail checks to see if your remote POP3 account is holding 
new mail for you.

 , or Check host for new mail on the File menu: Tells WinPMail to connect to your POP3 remote 
mailbox and download any mail waiting there. Unless you have the Message count only on idle poll 
control checked in the Network configuration dialog, new mail will also be downloaded any time 
WinPMail does a check during idle time.

 , or Check and send mail on the File menu: Has the same effect as selecting both the options described
above in a single connection.

Review queued mail on the File menu: Allows you to examine and change mail in your mail queue 
waiting to be sent. You can edit queued mail any time up to the point when Pegasus Mail actually 
attempts to send it: at that time, WinPMail converts the queued message into its final form and from then 
on, you can only delete that message from the queue.

Enter offline mode and Leave offline mode on the File menu: When you enter offline mode, WinPMail 
will cease all POP3 and SMTP activity including idle checks, and will no longer establish any connection 
to your hosts. While in offline mode, you can create, edit and read mail as normal, just without any 
network activity. Offline mode is useful if you are away from your network connection (for instance, 
travelling on a plane) but still want to work with your mail. Once you select Leave offline mode from the 
File menu, normal network activity will resume. You can force WinPMail to start in offline mode by 
adding the commandline switch -O (that's an "oh", not a zero) to the Program Manager Icon you use to 
run the program. If you travel a lot, you may want to consider creating a separate icon for running 
WinPMail in offline mode.



WinSock, or the Windows Sockets Interface is a standard way of providing network services under 
Microsoft windows. WinSock is usually used to provide access to the Internet TCP/IP network protocols 
although it can in theory provide other services as well. The advantage of WinSock is that applications 
can use Network services without knowing anything about the vendor-specific details of the transport 
modules installed on your system. This means that WinPMail can use any WinSock implementation no 
matter which vendor supplies it nor how it is actually implemented at the hardware level.

WinSock support is always provided by means of a DLL called WINSOCK.DLL which will be installed 
in either your Windows directory or somewhere on the path.



POP3 (Post Office Protocol, version 3) is an Internet standard which defines a mechanism for accessing a
mailbox located on a remote host machine. In order to use POP3 services, you require a user identity, or 
account on the host machine; when people send mail to you, they send it to your account on the host, 
which receives it and stores it in a mailbox for you. The next step is to run a program which supports the 
POP3 protocol (such as WinPMail): the program logs into the remote host on your behalf and copies any 
unread mail on the host to your local machine for reading. The copy of the mail remaining on the remote 
host can then be deleted (although most POP3 mailers make deletion an option).

POP3 is a necessary protocol because your PC will usually not be running all the time and hence will not 
always be available to receive mail directly from the Internet. A larger machine, such as a Unix system, 
typically will be on all the time, and so is better suited to receiving your mail for you. POP3 only defines 
the retrieval of new mail - mail is sent using the SMTP protocol.

POP3 is described in detail in several RFCs (Internet Standards Documents); the document on which 
WinPMail's POP3 implementation is based is RFC1725.



SMTP (Simple Mail Transfer Protocol) is the standard mechanism by which mail is delivered on the 
Internet and on TCP/IP networks. A very old protocol, its qualities are its robustness and ease of 
implementation. On the negative side of the ledger, SMTP is an extremely primitive protocol with no 
well-defined support for non-text attachments or international character sets. Because SMTP was 
originally designed for large multitasking systems which run continuously, it has certain design 
characteristics which make the reception of mail on PCs a difficult proposition. Because of this, most PC-
based mailers which use the TCP/IP network protocols use SMTP to send mail, but use another protocol 
called POP3 to receive mail. WinPMail uses this approach.

With over 15 million connectable addresses, SMTP is currently the most widely-used electronic mail 
protocol in the world and is likely to remain a potent force for several years. The SMTP protocol is 
documented in the Internet standards document RFC-821.



Setup for standalone operation

Welcome to Pegasus Mail! Before you begin using the program, you will have to provide Pegasus Mail 
with a small amount of information about your system and its configuration. This is needed so that 
Pegasus Mail knows where to store your mail folders, address books and other mail-related files, and so 
that it knows who you are.

The screen in front of you has three fields you should fill in. The first, Home mail path, is the DOS path 
to the directory in which your home mail folder should be located. The default value, C:\PMAIL\~8, 
tells Pegasus Mail to use the directory C:\PMAIL: the special string ~8 stands for the first eight 
characters of your username, and is replaced by Pegasus Mail before it uses the path. So, if you entered 
Peter as your username, Pegasus Mail would set your home mailbox location to C:\PMAIL\PETER. 
Using the special substitution this way means that more than one person may use the mail system on the 
same machine and ensures that their mail is kept separate. If you prefer not to use drive C: for your mail, 
or if for any other reason you need to change the path, you may do so provided the path you enter is legal,
although we recommend you use the default value unless you have good reasons to change it. The path 
you supply need not exist - Pegasus Mail will create it as necessary.

Your user name:    Enter in this field the name by which Pegasus Mail will recognize you. As described 
above, you can tell Pegasus Mail to use the first eight characters of this name as a way of identifying your
home mailbox. Please ensure that your username contains only letters and numbers - it must not contain 
spaces or special characters, because Pegasus Mail will use it as a DOS filename when naming your 
mailbox directory.

Save your username in WIN.INI:    Usually, when you start Pegasus Mail, it will open a small dialog 
asking for your username. If you are the only person using this system, you can bypass this step by telling
WinPMail to store your username in the Windows setup file, WIN.INI. Once you have done this, the 
system will always run using the name you supply, so do not check this control if there are other people 
using this system for mail as well. You can also specify the username WinPMail should use by means of a
DOS environment variable called PMUSER.



Noticeboards

Pegasus Mail's noticeboard system is like your own mail folders, the principal difference being that 
people other than you can see them and read the messages they contain.

A noticeboard may contain both notices, which you can read by pressing <Return> (the same way as in a 
regular mail folder), and can also contain other noticeboards. If you double-click on a noticeboard entry, 
Pegasus Mail will open that noticeboard and show its contents in the list. If you have opened a 
noticeboard, then there will always be a special entry at the top of the list marked .., which will take you 
back to the parent noticeboard.

Noticeboards have two names - a short name, which is used by Pegasus Mail to keep track of where you 
are, and a long name which contains a description of the purpose of the noticeboard. Short names are 
joined together with period characters to create paths, showing where a noticeboard fits into the hierarchy 
of noticeboards - so, the topic comp.sys.mail refers to a topic called mail which can be found in another 
topic called sys, which in turn is found in the topic comp.

If you are permitted to post notices in the current noticeboard, then the text Post will appear next to the 
topic's entry in the list: in a read-only topic you may only read the message, not add or delete them. If you
have administrator rights in the current board, the word Administrator will appear next to the topic's entry.
As an administrator, you can delete messages in    the noticeboard, and create new noticeboards within it. 
Administrators are also automatically allowed to post and read messages in the topic.

Posting notices
Following up
Administration



Posting notices

If the noticeboard administrator has permitted you to do so, you can post a new notice on the board by 
clicking the New post button. You can only post into the currently-displayed noticeboard - it is not 
currently possible to 'cross-post' to other boards.

Posting a notice is a simplified version of posting a mail message - you only have to enter a subject and 
then type in your notice. Pegasus Mail automatically supplies the name of the noticeboard in which the 
notice is to be placed. 

While you compose your notice, you can add attachments to it in exactly the same way as you would to a 
mail message, by clicking the Attachments button or by pressing <F7>.

To finish your notice and post it to the noticeboard, click Send or press <Ctrl+Enter>. Your notice will 
appear on the noticeboard immediately.



Following up

Following up is the process of posting a public reply to a notice which is already in the board. Think of a 
followup as being your contribution to an ongoing conversation.

Followups are always posted into the same board as the notice to which they refer. You cannot change the 
subject field of a followup - Pegasus Mail automatically sets it to the subject of the original message 
prefixed with the characters Re:. The reason you can't alter the subject is to ensure that all notices on a 
particular topic will be grouped together when people use the Sort by subject sorting option.

If you want to post an entirely new notice (one with a new subject field), but want to copy some text from
an existing notice, read the original notice, mark and copy the text you want from the notice, then post a 
new message, and use the Paste or ^V command command to insert the text you copied into your new 
posting.



Noticeboard Administration

Noticeboards cannot be directly administered from within this release of Pegasus Mail for Windows, 
although it will be possible in future versions. In order to administer a noticeboard, you must either use 
Pegasus Mail for DOS v3.1 or later, or manually edit the NB.ID file in each noticeboard directory. NB.ID 
is a simple text file containing instructions which tell Pegasus Mail how to work with the noticeboard.

Creating a noticeboard:  Follow these steps to create a noticeboard 

1: Start a DOS shell, and create a subdirectory in the noticeboard where the new noticeboard is to appear. 
Any name will do for the directory.

2: In the new directory, use a text editor to create a file called NB.ID. NB.ID can contain the following 
keywords:

Long name: The full name of the board
Short name: The abbreviated name of the board
Administrator: ID of a user who administers the board
Post: ID of a user who can post to this board.
Browse: ID of a user who can read notices in the board.

Post, Browse and Administrator each take only a single user ID, but may appear multiple times in the file.
On NetWare systems you can specify NetWare groups in these fields by prefixing the name of the group 
with a # character.

Rights: When you create a noticeboard in Pegasus Mail, you are really working within two different sets 
of rights; there are the rights that Pegasus Mail applies to a noticeboard to determine whether or not a 
person can see it and its messages, and there is also the actual operating system rights which apply to the 
directory structure on the disk. If the operating system and Pegasus Mail do not agree on the rights 
assignments, things won't work.

As an example, just because you have told Pegasus Mail that user "JBLOGGS" can post messages in a 
particular noticeboard, it does not follow that he will be able to do so if he does not actually have the 
operating systems rights to create files in the noticeboard directory.

As a result, for each class of user for a noticeboard (Administrator, Browser and Poster) you will typically
have to run some kind of command on your LAN which allows the user the actual physical access he 
needs to operate as indicated within a noticeboard.

A topic administrator must have at least the rights required on your system to be able to create and 
remove files and directories in the board directory.

A topic browser must have at least the rights needed to be able to see and open files in the directory.

A topic poster must have the rights of a browser and whatever else is needed to create and write files in 
the directory.

If you are running under NetWare 3.x or earlier, then you will have to use the NetWare "GRANT" 
command to assign appropriate rights for each type of poster.



Mail filtering rules

Pegasus Mail allows you to perform automated processing of mail when messages matching particular 
conditions are met. You might use this, for example, to move all "confirmation of reading" replies from 
the current folder to another folder -- in this case, the condition for which you would test would be the 
first 4 characters of the "Subject" field being "RCPT". Pegasus Mail can provide this automated 
processing in the following situations --

Automatic filtering when the new mail folder is opened or closed
Filtering your copies to self
Using rules to filter the contents of any folder

You can use either of two types of matching in your rules: matching on predefined headers and matching 
on regular expressions.

A wide range of actions can be triggered by a rule. Rule processing continues until all rules have been 
applied, or until the message is moved to a folder or deleted as the result of a rule.You can define multiple
rules with the same trigger conditions to have multiple actions applied to the same message -- Pegasus 
Mail will apply them in the order in which they appear in the list. Make sure that any rules containing 
"Move" or "Delete" actions are the last you define for a particular trigger text, since rule processing on a 
message stops after these actions.

Matching on text in message headers
Matching on regular expressions
Actions that can be triggered by a rule



Automated filtering of new mail

You can define a set of rules that are automatically applied to the new mail folder when you open it, and 
to any new mail that arrives in the new mail folder while it is open, and another set of rules that are 
applied automatically when you close the new mail folder. These options are especially useful if you are 
subscribed to mailing lists and want to reduce the clutter in your new mail folder by sorting your list mail 
out to folders, where you can peruse it at your leisure.

To define new mail filtering rules choose Edit new mail filtering rules from the Mail filtering rules option
on the File menu. The rule sets applied when the folder is opened and closed respectively can be edited 
separately.

If there are mail messages that are acted upon by a rule but are not deleted or moved from the new mail 
folder, those messages will be marked as having been read to prevent them from being repeatedly filtered 
when you open the new mail folder. Mail that has been read but left in your new mail folder is never 
affected by new mail filtering rules unless you mark it as unread.



Filtering your copies to self

You can create a set of rules that are applied to any copies of mail you send using the Copy self option in 
the message editor. This allows you, for example, to move your personal copies into folders based on the 
person to whom they are addressed or the subject matter. You can define any rule action in your copy self 
filtering rules, but the most common actions will usually be to move the message or to set its colour.

To define rules that should apply to your copies to self, choose Edit copy-self filtering rules from the Mail
filtering rules option on the File menu.

If no copyself filtering rule results in the message being deleted or moved, Pegasus Mail will 
automatically file the copy to self into the Copyself folder you have designated in your General 
Preferences settings.



Filtering mail in any folder

Pegasus Mail lets you define sets of rules that you can apply to any folder at any time. Unlike new mail 
filtering, this kind of rule set is never applied automatically -- you must explicitly invoke it. Furthermore, 
unlike new mail filtering, general rule sets will filter both read and unread mail alike (new mail filtering 
will only filter unread mail). You can create as many different rule sets as you wish and may invoke them 
on any folder, including the new mail folder.

To define a general rule set, choose Create/Edit general rule set from the Mail filtering rules option on 
the File menu. This will open the ruleset selector dialog, in which you can create, delete and rename rule 
sets.

To apply a rule set you have created to a folder, choose Apply general rule set to folder from the Mail 
filtering rules option on the File menu.



Matching on text in predefined message headers

In the majority of cases, you will simply want to detect messages which contain particular addresses, or 
which have particular text in the subject field. Pegasus Mail provides an easy way of triggering rules 
based on conditions like this.

In the Rule Editor, make sure that the radio button labelled "In these headers" is checked; this will enable 
the header controls next to it. Simply check the fields in which you would like the test to be made, then 
enter the text you would like to match in the "Trigger text" field. You can check as many of the six 
controls as you wish, although some are probably mutually exclusive (such as "From:" and "Subject:"). 
You should usually check at least one control, although it is permissible to check none (this is a useful 
way of disabling a rule without deleting it).

Exact matching:    Pegasus Mail usually triggers the rule if any of the fields you check contains the trigger
text anywhere; if you want Pegasus Mail to trigger only on an exact match, enter a caret (^) as the first 
character of the trigger text. Doing this means that the rule will only trigger if the header and the match 
are the same length and contain the same characters. The match is always case-insensitive -- this cannot 
be changed even for an exact match.

Examples:

If "Subject:" is checked and the trigger text is "SUBSCRIBE" then the rule will trigger if the subject is 
any of the following:

Subscribe
I want to subscribe to your list
Notice to all subscribers

If "Subject:" is checked and the trigger text is "^SUBSCRIBE", then the rule will trigger only for the first 
of the examples shown above ("Subscribe")



Using regular expressions as rule triggers

Using regular expressions to trigger rules is more complicated than matching on predefined headers but is
considerably more powerful, since it allows you to match on any message header, or even on the contents 
of the message body.

To use a regular expression trigger, make sure the radio button labelled "As an expression" is checked in 
the Rule Editor - this will enable the scope controls next to it. You can restrict the extent of the search 
using the scope controls - **NOTE** you should be careful when using either of the scopes which permit
searching the message body, since this can dramatically increase the time it takes WinPMail to open the 
new mail folder (sometimes by a factor of as much as 10 times or more). You need only have one action 
whose scope is the message body in your entire rule set to cause this increase in processing time, although
subsequent rules in the message body scope do not introduce appreciable further delay.

Next, enter the regular expression you wish to use in the "trigger text" field. WinPMail recognizes the 
following metacharacters in expressions:

* Match any number of any characters
? Match any single character
+ Match one or more occurrence of the last character
[ ] Encloses a group of characters to match. Ranges can

be specified in the group using '-'.

All metacharacters can be used as many times as necessary. Regular expression searches are always case-
insensitive. To search for literal occurrences of any of the characters *, ?, + or [, you must enclose them in
group markers (so to search for a literal asterisk, enter [*]). Regular expressions do not cross line 
boundaries - you can only perform expression matching within individual lines in the message. If the first 
character of your expression is not '*', then matching must begin at the start of the line - so if you want to 
use a regular expression to find lines containing text at any position, you must use a leading '*' character 
(this is the reverse of matching on predefined headers, where the match is always open unless exact 
matching is specified).

Examples:

MIME-VERSION:*[12]*
or MIME-Version: +[12]*

Matches "MIME-Version:    1.0"
but not "MIME-Version: 3.0"
(The '+' matches multiple successive spaces)

*pmail.gen.nz*
Matches any line containing "pmail.gen.nz"

Priority:*urgent
Triggers a rule for urgent mail



Actions that can be triggered by rules

When a rule's trigger text matches text in the message, its action is performed. Actions are selected from 
the list in the Rule Editor -- selecting an action will often result in you being prompted for more 
information, such as selecting a destination folder, or entering a file name.

Rules are processed until a rule is triggered whose action results in the message being either deleted or 
moved to another folder. Because of this, you should always take care to ensure that rules containing 
Move or Delete actions are the last ones you define for a particular trigger text.

You can also force rule processing to stop for a specific message by using the Exit this rule set action.



Regular expressions: a regular expression is a description of an expression which permits matching 
based on patterns rather than on exact correspondence. If you have ever used a DOS command like "DEL 
*.BAK" then you have already used a regular expression -- what this command is really saying is "Delete 
all files where the name contains anything and the extension is BAK".

When you compose a regular expression, you use a combination of literal characters which must be 
present (such as the "BAK" in the command above) and special metacharacters (also called wildcard 
characters) which can match varying numbers of characters, or characters in specific groups only. As an 
example, MS-DOS supports two metacharacters - *, which means "match any number of any characters" 
and ?, which means "match any single character in this position".



Options for replies

Pegasus Mail offers you considerable control over the way replies are generated. Depending on the state 
of the Offer advanced options for replies setting in your General Preferences, you will see one of two 
possible dialogs when you reply to a message. The first is a simplified version containing only a subset of 
the full range of reply options. The second dialog offers all the controls in the basic version and more, and
is the one discussed here.

The reply dialog has three sections, each controlling a different aspect of the reply. Settings in this dialog 
are "sticky" -- that is, they are remembered from session to session.

Original Message
This section contains controls which determine how much (if any) of the original message is included in 
your reply.

Include original message in reply    If checked, WinPMail will include the text of the original message in 
your reply. Including the text to which you are replying provides a context for the recipient, and is an 
important part of the process of using electronic mail. Pegasus Mail can include a maximum of 31000 
characters from the original message into your reply.

'Comment out' the original text    If checked, WinPMail will attach a visual indicator (usually "> ") to the 
start of every line included from the original message. Doing this creates a clear visual distinction 
between the original message and your text.

Copy original CC field into reply    If you want to send a carbon copy of your reply to the same people 
who received carbon copies of the original message, check this control. WinPMail will copy the first 180 
characters of the original CC address into your reply.

Formatting
This group of controls dictates the visual presentation of your reply.

Reformat line breaks in original    If checked, WinPMail will reformat the included message so that it fits 
within your message editor's default margins. WinPMail attempts to preserve indenting and "commenting-
out" of the original text, but you may find that tables and other textual elements which depend on 
tabulation may be misaligned when you use this option.

Omit message headers    WinPMail usually includes the most important headers from the original message
into your reply. If you check this control, it will omit all header information from the reply.

Use custom header line    If you check this control, WinPMail will open another dialog and will prompt 
you for a custom header line, which allows you to create the first line of the reply automatically based on 
information from the original message. The default header line is "On ~D at ~T, ~F wrote:" -- the ~D, ~T 
and ~F characters are special placeholders which WinPMail replaces with the Date, Time and Sender's 
personal name from the original message respectively. The other valid substitutions are ~S, which is 
replaced with the Subject field from the original message and ~A, which is replaced by the sender's full 
reply address. If you want to enter a line break into a custom header, add the substitution ~L at the point 
where you would like the break to occur.Any custom header line you define is remembered from session 
to session, even if you uncheck the control.

Addressing options
The controls in this section allow you to choose addresses from the original message to which replies 



should be sent. WinPMail extracts all the addresses it can find from the headers of the message and shows
each of them next to a control: checking the control includes that address in the "to:" field of your reply. If
you leave all controls unchecked, WinPMail has default addressing logic which will produce valid 
addressing in almost all cases. You will typically use these options when replying to mail from mailing 
lists, or if you want to start a new conversation with a secondary recipient of the original message.

Checking the control labelled Address reply to all recipients tells Pegasus Mail to attempt to send your 
reply to every person who received the original message. Because this may entail a large number of 
addresses and individual address fields in WinPMail can only accept 180 characters, WinPMail will 
automatically create a temporary distribution list when you choose this option and will place the name of 
that list as an address in the "To:" field of the reply. Note that because you were a recipient of the original 
message, checking this control means that you will get a copy of your reply mailed to you. The setting of 
this control is not sticky -- it is always reset on each reply.



The Folder Manager Window

When you select Mail folders from the File menu, or click the Folder icon on the toolbar, the Folder 
Manager window opens. This window lists all the folders and trays you have created and can be left open 
on your desktop while you run the program.

While the Folder Manager is open, you can drag messages from any folder window and drop them onto 
any folder entry it contains. You cannot drag messages onto a tray entry because trays can only contain 
folders and other trays.

When the Folder Manager window is frontmost, you can type the first few characters of a folder or tray's 
name to select it quickly. Pressing <Enter> when a tray is selected will open (or close) that tray, or will 
open a folder's browser window if selected.

Click the New button to create a new folder or tray.

Click the Rename button to change the name of a folder or tray. Note: for trays, you can only change the 
tray's long name using this command -- you cannot rename the DOS file in which the tray's information is
stored.

Click the Delete button to delete a folder. You can only delete trays if they contain no entries.

Click the Open button to open a folder or tray. You can also double-click on the entry in the list, or 
highlight it and press <Enter> to open it.

The Folder menu
When the Folder Manager window is frontmost, the Folders menu is enabled on the menu bar: the 
Folders menu contains the following options:

Reindex folder    From time to time, a folder's index file may become corrupt, which can result in errors 
when you attempt to open it. If this happens, highlight the folder and select this command to force 
Pegasus Mail to rebuild the index file. Reindexing will work reliably if the actual messages in the folder 
are intact, but may result in the loss of some status information (such as whether or not you have replied 
to a message, or forwarded it). A side-effect of rebuilding a folder is that some deleted messages may 
reappear the next time the folder is opened. You cannot reindex tray entries.

Check consistency    This option attempts to verify that a folder is intact. On rare occasions folder index 
files can become damaged, which can cause problems in long-term use. Pegasus Mail automatically 
invokes this option before recovering deleted message space from folders ("compressing"), but if you 
want to ensure that a folder is intact, you can perform a consistency check manually at any time.

Check tray list    If you create folders using an old version of Pegasus Mail after you have run this version 
of WinPMail, the folder will not appear in the tray list, because WinPMail stores the folder list in a way 
which the old version of Pegasus Mail does not understand. Selecting this option tells Pegasus Mail to 
compare its tray list (the list which it maintains of all folders and trays) with the folders which actually 
appear in your home mailbox. If it finds any folders which are not in the tray list, it will add them to the 
main tray for subsequent use. This command is completely safe and may be used routinely if you wish.

Cut folder, Paste folder    Select this if you want to move a folder or tray to another tray. The highlighted 
folder or tray will be removed from the list and information about it will be saved in a disk file (called 
TRAYSAVE.PM) in your home mailbox. Once you have chosen the Cut folder command, Paste folder 



command will be enabled, allowing you to insert the entry you have cut into the list at the position before 
the cursor. Navigate to the place in your tray hierarchy where you want the item to appear, then choose 
Paste folder from the Folders menu and Pegasus Mail will insert the saved item for you. It is safe to exit 
from Pegasus Mail without pasting the entry - you can paste it at any time after you have moved it.

Compress folder    When you delete a message from a folder, Pegasus Mail does not immediately reclaim 
the space it occupies; instead, it waits until you have deleted around 20000 characters from the folder then
recovers all the space in a single pass. This deferred compression improves the performance of the 
program at the cost of some disk space. Select this option to force Pegasus Mail to recover the space from
a folder immediately. Compression is always a safe option and does not result in the loss of anything 
other than deleted information. You cannot compress tray entries.

Close all open trays    Select this option and Pegasus Mail will flatten your folder hierarchy so that only 
the top level is visible in the Folder Manager window.

Quick open    Lets you open any of your Quick Folders



A tray is a specialised type of folder which can contain other folders or trays, but not messages. A tray is 
just like a subdirectory on your hard disk -- it can contain files and other subdirectories, but does not 
contain data of its own. You can use trays to create a hierarchy within your folder structure -- to keep 
folders on related topics together in one place.

There is no limit to the depth of a tray hierarchy, but you will generally find that three to four trays deep is
a reasonable maximum for easy management.

Organizing your mail folders in a hierarchy can make your mail easier to find and can result in 
considerable performance improvements in the program when it has to list or open your folders.



MIME (Multi-purpose Internet Mail Extensions)
MIME is an Internet standard for the transmission of data of any type via electronic mail. It defines the 
way messages should be formatted and constructed and has provision for indicating the type and nature of
the contents of a message, and for preserving international character set information. In most cases, a 
MIME message can be read correctly on any kind of system which has a MIME-compliant mail program.

MIME provides direct support for graphic images in GIF and JPEG format, Video images in MPEG 
format, and Audio data as well. It also has a Digest format for sending multiple mail messages at once 
(Pegasus Mail displays MIME digests in a manner very similar to a folder).

Pegasus Mail will automatically handle incoming MIME messages without any intervention from you. 
The decision over whether it should generate outgoing messages in MIME format is yours -- to enable 
MIME features, click the control in the Special view of the message editor. Once checked, the setting will
be remembered for all subsequent messages. The only reason you would not use MIME formatting for 
Internet mail would be if you knew your correspondent did not have access to a MIME-compliant system.

MIME is described in the Internet Standards Document RFC1521.



Troubleshooting

At some stage, things will probably go wrong -- there's no escape from Murphy's Law. This section lists 
the most common problems and solutions known to us at the time of release of this version of the 
program. See the next section, Technical support for information on how to obtain the most up-to-date 
lists of common problems and solutions.

READ THIS FIRST!!!
WinPMail and the Novell NetWare environment
WinPMail and Windows 95
WinPMail and WINSOCK.DLL
"Cannot create container file" errors
International character set problems
Other problems



Murphy's Law:    "Anything that can go wrong, will go wrong".
There's also Parkinson's Law -- "Work expands to exceed available time".

Forget Einstein -- these are the laws that REALLY govern the universe.



First steps for troubleshooting

It has been our repeated experience that the vast majority of problems people have with WinPMail fall 
into three categories, none of them actually to do with the program itself:

1: Configuration problems    more than 80% of all problems reported to us result from simple 
misconfiguration of the system. Pegasus Mail doesn't require a great deal of configuration, but it is 
important that the configuration it does require be done correctly. Always read WGUIDE.HLP carefully, 
especially the "Important information" and Installing WinPMail" sections.

2: Problems with other people's software    this is particularly true with WINSOCK.DLL, because the 
quality of available WINSOCK implementations varies widely. If your problem results in a GPF 
(Windows-speak for a crash), check the report Windows generates carefully - it will say something like 
"WINPMAIL caused a GPF in module XXXXXX"; the actual cuplrit is whatever is named in XXXXXX:
if it is the name of a DLL, especially WINSOCK.DLL, then your problem almost certainly is not in 
WinPMail but in a third-party product.

3: System problems    some very common problems can be caused by incorrectly installed network 
drivers, by marginal hardware (this is especially true of modems), or by running in environments with too
little disk space or memory. In the network environment, incorrect or inadequate trustee and access rights 
can also cause innumerable problems. Always check these external influences before assuming that 
WinPMail itself is at fault.

Finally, if WinPMail is producing an error message, please read it carefully! Very often, the solution to 
the problem will be shown in the message itself.



WGUIDE.HLP is the Pegasus Mail online guide. It is a Windows Help File supplied in the original 
Pegasus Mail archive you retrieved. If you ran Pegasus Mail's setup program to install it, WGUIDE will 
appear as an icon in the "Pegasus Mail for Windows" group created by setup. When you double-click it, it
will display a menu of topics about installing and using Pegasus Mail.



WinPMail and the Novell NetWare environment

How can I stop WinPMail from running in "NetWare mode"?
You can force WinPMail to run in standalone mode (ie, to ignore the connection to the NetWare server) 
by changing the command line you use to run the program to:

WINPMAIL -A
This commandline switch also works for the DOS version of Pegasus Mail.

WinPMail tells me it can't find my home mailbox, but it's there!
There are three possible causes for this problem:
[*] 1: You may be running Windows in Standard mode while connected to a NetWare server, and your PC
is using the Novell NETX shell set. This combination will provoke a bug in the NetWare API libraries, 
especially if your machine is a 286. The only solution is to move to the VLM shell set or to step back to 
WinPMail 1.02 (which uses an older API set).
[*] 2: If you are running in standalone mode (not connected to a NetWare server), your standalone 
configuration might be incorrect - the most likely cause is an invalid path in either the home mailbox or 
new mailbox fields in PCONFIG. Try deleting the file PMAIL.CFG in the directory where 
WINPMAIL.EXE is located and re-entering the values the next time WinPMail starts up.
[*] 3: You may be running under NetWare 4.0x in a directory services context which is not the Bindery 
Context. WinPMail is a Bindery-based NetWare application and requires information from the NetWare 
Bindery, which is poorly emulated under NetWare 4.0x. The only solution is to have your usercode 
moved into the Bindery Context.

WinPMail runs in standalone mode even though I'm connected to a NetWare server
Windows reports "Cannot find NETWARE.DLL" when starting WinPMail
You probably have not installed NetWare support into your copy of Windows. Run the Windows setup 
program and see what Network it thinks you are using; if it says "None", choose "Novell NetWare" and 
insert the disks it asks for. You should also make sure you are using the most recent NetWare drivers from
Novell - at the time of writing these are contained in the files WINDR2.EXE, VLMUP3.EXE, 
NET33X.EXE and NWDLL2.EXE, available via FTP from ftp.novell.com in /novlib/novfiles, or in the 
NOVUSER area on CompuServe. The "Cannot find NETWARE.DLL" message is an error in Windows - 
there is no "NETWARE.DLL" - it is looking for NETWARE.DRV.

Windows, The "Black Screen of Death" and broadcast messages
If your copy of Windows crashes with the "Black Screen of Death", or your system locks up or behaves 
erratically when you receive the broadcast "New mail" notification messages Pegasus Mail generates, 
then you almost certainly have a NetWare Shell problem. Make sure you are using the absolute most 
recent driver files from Novell (see the preceding entry for details on getting these) and take particular 
care to delete all old versions of these files (especially NWPOPUP.EXE and NETWARE.DRV) right 
across your DOS path.



WinPMail and Windows 95

I'm running Windows 95 and getting GPFs in NWCALLS.DLL
There is a bug in Windows 95's NetWare emulation such that it reports a server connection even when 
there is none actually available. You can fix this easily by forcing WinPMail to start in standalone mode 
by adding the switch "-A" to its command line.

My Windows 95 users can't send mail via Mercury - it gets returned with a "missing $$ signature" 
diagnostic.
There appears to be a severe bug in the Windows 95 NetWare Queue Services emulator which means that 
the first four bytes of jobs written directly to queues by programs will be corrupt. The only workaround I 
have been able to find for this is to switch Mercury and WinPMail into Mercury's spooler submission 
mode instead of queue mode. This problem may also affect Windows NT v3.51 users, because that system
appears to use the same Queue Services code with the same bug.

I'm trying to use the Microsoft WINSOCK.DLL supplied with Windows 95 but am having connection 
problems.
This, and variants of it, are usually attributable to having WINSOCK.DLL files other than the Microsoft 
version on your system. This is particularly likely to happen if you have upgraded to Windows 95 rather 
than doing a fresh install. Hunt through your system making sure that there is only one copy of 
WINSOCK.DLL present and that it is the Microsoft offering.



WinPMail and WINSOCK.DLL

The quality of Windows Sockets implementations currently available for Windows seems to be extremely
variable, so if you have problems with WINSOCK- based mail in WinPMail, please check first that you 
have the current version of your WINSOCK.DLL and any support software, and that it's correctly 
configured.Next, if you are getting connection problems, try expressing the address of the host to which 
you want to connect using dotted IP notation instead of an address (or vice-versa).

Many problems using WINSOCK across slow SLIP or PPP links arise from timeouts being set too short - 
set a much longer timeout value in your network configuration screen in these cases (I recommend up to 
120 seconds).

WinPMail v2.0 and later uses "non-blocking sockets" to obtain the greatest level of control of TCP/IP 
communications. Some WinSock implementations do not handle non-blocking sockets well. If your 
WinSock implementation has problems connecting with WinPMail, or if performance is erratic, try 
changing the command line you use to run WinPMail to:

WINPMAIL -Z 1024
This will force WinPMail to use blocking sockets, at the price of lower performance and possibly 
occasional conflicts between POP3/SMTP and TCP/IP-aware WinPMail extensions.

I don't get the Network Configuration or other WinSock-based entries on the File menu
[*] WinPMail may be unable to find WINSOCK.DLL - make sure it is on the path, in \WINDOWS, or in \
WINDOWS\SYSTEM. On some systems, especially Windows NT, you may find you have to force 
WinPMail to "Blind load" WINSOCK.DLL -- you do this by changing the command line you use to run 
WinPMail to:

WINPMAIL -Z 128
[*] You may have the Winsock loading field in your Advanced settings preferences dialog in WinPMail set
to Never. Set it to On demand or Always then exit and restart the program.

Some people are trying to reply to my POP3 server address, which isn't a valid address to the outside 
world, but I've set a proper From field value in the Advanced Configuration Options dialog - why is 
Pegasus Mail still using the wrong address for me?
There is unfortunately a small group of mail systems on the Internet that attempt to derive your reply 
address from a specialised and rarely-used field in the message called "return-path". The "return-path" 
field is formed according to special rules by Pegasus Mail, using an approach that attempts to provide the 
greatest reliability in the widest number of systems, but inevitably there are going to be some cases where
you need to work another way. If you encounter this problem, check the control labelled Use this from 
field to form the SMTP envelope in the Advanced Configuration Options dialog of the Network 
Configurastion dialog.

WinPMail reports "Invalid password" when I connect to my POP3 server, but I've double-checked and the
password is right.
[*] The password may be right, but your username may not be (for security reasons, most POP3 servers 
will accept any username and fail the password automatically if the username is invalid). The most 
common cause of this is putting a full address in the "username" field of the Network Configuration 
dialog's POP3 section. If you can see an '@' symbol in this field, then it's wrong - WinPMail only wants 
your basic username, which is everything preceding the '@' in your address.

I'm trying to use the Microsoft WINSOCK.DLL supplied with Windows 95 but am having connection 
problems.
This, and variants of it, are usually attributable to having WINSOCK.DLL files other than the Microsoft 



version on your system. This is particularly likely to happen if you have upgraded to Windows 95 rather 
than doing a fresh install. Hunt through your system making sure that there is only one copy of 
WINSOCK.DLL present and that it is the Microsoft offering.

I'm trying to use the 32-bit Microsoft WINSOCK.DLL supplied with Windows 95 but it won't autodial 
when WinPMail loads it..
This appears to be a problem in the 32-bit WINSOCK.DLL itself - as far as we have been able to 
determine, the 32-bit version will not autodial if loaded by a 16-bit application such as Pegasus Mail. At 
the time of release we are taking this issue up with Microsoft.

How can I prevent WinPMail from autoloading WINSOCK.DLL?
WinPMail has built-in support for a variety of e-mail protocols using the TCP/IP networking protocol. To 
provide this support, it looks for a file called WINSOCK.DLL when it starts up; WINSOCK.DLL is a file 
supplied by your TCP/IP vendor which provides a standard interface to TCP/IP network services for 
Windows programs. If you do not want WinPMail to load this file (and hence not to provide access to its 
built-in mail TCP/IP mail services), do one of the following:
[*] Prior to running Windows, enter the command "SET WINPMAIL=1" from the DOS prompt. You 
cannot do this from a Windows DOS session - you must do it prior to running Windows
[*] Change the command line the Program Manager uses to run WinPMail so that it includes the switch "-
Z 1". You can use this switch with all other switches in the program.
[*] Go to the Advanced settings preferences dialog in WinPMail and set the Winsock Loading field to 
Never.



"Container file" errors and what they mean

One of the most common errors you may see from WinPMail is a message saying:

      WinPMail has failed creating the container file for a message

This is also one of the harder error messages to diagnose, but in general it means that Pegasus Mail has 
attempted to create a file for delivery and the operating system has reported a failure on the operation. 
The most common causes for this problem are:

[*] (In NetWare mode) This message can indicate several things:
* You may be out of disk space on the file server volume where the recipient's mailbox is located (or the 
submission directory if you are sending mail via Mercury)
* You may have insufficient rights in the destination directory
* The destination directory may not exist (this can happen on NetWare 4.x servers running in Bindery 
Emulation mode when the recipient has never logged into the server, because NetWare 4.x only creates 
the user's SYS:MAIL mailbox when he or she logs in the first time).
* If sending mail between servers, this may indicate an error in the configuration of the inter-server 
delivery account created for Pegasus Mail's use, usually a password or connection restriction, or a lack of 
rights in the destination server's SYS:MAIL directory.

[*] (In standalone mode) You may have addressed the message to a local user who does not exist. 
Because Pegasus Mail can manage multiple users on the same machine, if you enter an address like 
"david", or "betty" - namely, an address with no domain portion - Pegasus Mail will assume it refers to a 
user on your own machine and will try to deliver it locally. If you have no users other than yourself on 
your machine, you may want to set the "Use for all outgoing mail" flag in the Network configuration 
dialog - this tells Pegasus Mail that there are no local users and to send everything via the SMTP 
transport.



International character set problems

Pegasus Mail users in countries where English is not the primary language will often run into problems 
using accented characters in electronic mail. Problems with accented characters are not a sign of 
ignorance or carelessness on the part of Pegasus Mail's developer (who studied French for 11 years and 
German for 5) -- rather, they reflect a very general problem with computers in that there is very little 
standardisation on character sets and the way they are represented.

The first thing to do to improve the situation is to turn on Pegasus Mail's MIME support - MIME goes a 
long way towards dealing with International character set issues. Enable MIME support by checking the 
control in the Special view of the message editor.

You can customize the character sets Pegasus Mail uses for MIME messages by creating and compiling a 
file called WPM-LMTT.RSC, and placing it in the same directory as WINPMAIL.EXE. A sample source 
file for this resource, called WPM-LMTT.R, is supplied in the RESOURCE\ subdirectory of the directory 
where you installed WINPMAIL.EXE - examine it for details of the formatting required.

For non-MIME messages it is impossible to preserve 8-bit data accurately in any meaningful way -- when
sending non-MIME mail, Pegasus Mail will always convert accented characters to non-accented ASCII 
equivalents; this process is required by the Internet mail standard, RFC822, and cannot be subverted. You 
can customise the conversion process Pegasus Mail applies to your accented characters by providing a 
WPM-CHAR.RSC file in the same directory as WINPMAIL.EXE. As with WPM-LMTT.RSC, this file is 
compiled from source you provide, and a sample WPM-CHAR.R file is provided in the same location.



Other problems

The .WAV file I have chosen as a new mail alert sound doesn't work
By default, the new mail alert sound only works when WinPMail is minimized on your desktop.
[*] If you would prefer the alert sound to play any time new mail arrives, add the switch "-Z 512" to the 
WinPMail command line.

I have some users whose preferences don't get saved properly between
WinPMail sessions
WinPMail only saves your preferences when it believes they have changed during the session - sometimes
it may fail to detect changes.
[*] You can force WinPMail to save your preferences by holding down the Ctrl key while selecting "Exit"
from the file menu.
[*] This can also happen when user has no rights to read or write files in the temporary directory specified
in the TEMP or TMP environment variable, or in the "Temporary files directory" setting in the user's 
PMAIL.INI configuration file.

Why can't I see some of/all the mail folders I created using older versions of Pegasus Mail?
WinPMail supports hierarchical foldering using "trays", or containers in which folders can be placed. 
When it first runs, WinPMail creates a file called MAIN.PMT which is your main tray and contains all the
folders it can find in your home mailbox: from this point, it uses the file to maintain your hierarchy. If you
create a folder using an earlier version of Pegasus Mail after you have run this version, the new folder 
will not be added to the hierarchy file and WinPMail will not be able to see it.
[*] Solution: run WinPMail, and press <^L> to select a folder; choose "Check tray list"from the Folders 
menu. This instructs WinPMail to look for any folders which might be missing from your hierarchy and 
add them to it.

How can I stop WinPMail from running in "NetWare mode"?
You can force WinPMail to run in standalone mode (ie, to ignore the connection to the NetWare server) 
by changing the command line you use to run the program to "WINPMAIL -A". This commandline 
switch also works for the DOS version of Pegasus Mail.

Why do all my folders and other mail files appear twice in WinPMail?
If you can see two entries for each DList, Folder, Addressbook or other WinPMail file when you try to 
select one, and one is in blue, then you have probably installed WINPMAIL.EXE in the same directory as
your home mailbox (as opposed to using the recommended installation); this causes WinPMail to see 
every file as both personal and system-wide, and to list them twice.
[*] Solution: Move WINPMAIL.EXE, WINPMAIL.DAT, WPNNW3.DLL (if you are
on a NetWare system) PMAIL.CFG (if you are running on a standalone system) and WINPMAIL.HLP 
into another directory.

My new mail folder doesn't open at startup even though I have the option checked in my preferences.
WinPMail originates from the LAN world and is still far and away most heavily used there; in that 
environment, most users prefer to have the new mail folder open automatically only if there is actually 
new mail to display. This option is less useful for standalone users so a fix is provided.
[*] Solution: Add the switch "-Z 256" to the WinPMail command line (in the Program Manager Icon you 
created for it). This will force the new mail folder to open irrespective of its contents.



Technical support, manuals

Your first port of call for technical support for Pegasus Mail is WGUIDE.HLP and this help file. The 
answers to most questions can probably be found in these two files, especially in the Troubleshooting 
section on the WinPMail help menu.

If these resources don't turn up the answer for you, send a mail message to the Internet address 
support@pmail.gen.nz. This will retrieve an automatic reply listing all the available sources of help, 
including regularly-updated frequently-asked-question lists (FAQs), addresses for support mailing lists, 
and direct mail addresses for the program's author. The support@pmail.gen.nz account is also regularly 
scanned for questions not covered in the online information sources and mail sent there will receive 
answers depending on our current workload. Because mail to this account may receive direct replies, 
please always state at the very least which version of Pegasus Mail you are using (DOS, Windows or Mac
and the version number) and a short description of the problem you are experiencing.

Finally, printed manuals are available for Pegasus Mail at very reasonable prices. We don't guarantee 
you'll find the answer to every problem in the manual, but it is a handy, complete reference to the 
program. Manual purchases are totally optional - there is no pressure or obligation for you to purchase 
manuals: Pegasus Mail is provided as a free service and our primary objective is not the accumulation of 
money. We want you to enjoy using the program and benefit from the capabilities it offers you, and if you 
do not feel you need a manual to increase your enjoyment then that is the best compliment we could ask 
for. Information on ordering manuals can be found in WGUIDE.HLP and a copies of the order forms are 
contained in the files SU-ORDER.FRM and ORDER.FRM in the directory where you installed WinPMail.



Using Drag and Drop in Pegasus Mail

Pegasus Mail makes heavy use of Drag and Drop - picking something up by holding down the left mouse
button, dragging it to where you want to use it, then dropping it by releasing the mouse button. You can 
perform the following actions via drag and drop:

You can drag addresses from any Addressbook, from the Local User List, from the MHS Directory 
Service, from the Distribution List Manager window or from the Logged-in user list to any address or text
field in the program.

You can move messages from any folder window to any other folder window (even minimized on the 
desktop), or to a folder entry in the Folder Manager list. Holding down the Alt key while you drag the 
message will copy it instead of moving it.

You can copy an addressbook entry from any addressbook to any other addressbook by dragging between 
them. Holding down Alt while you drag the entry will move the entry from one book to the other instead 
of copying it.

You can drag messages from any folder window to any addressbook (even minimized) and WinPMail will
create an addressbook entry based on the information in the message.

You can drag a message from any folder window to any message editor field and Pegasus Mail will paste 
the contents of that message into the message you are editing at the cursor position, prompting you for the
portion of the message it should copy.

You can highlight text in any message you are reading and drag it to a message you are editing. By using 
Ctrl+Click to select disjoint areas in the message, you can copy several different portions of a message 
this way using a single drag operation.

Finally, you can drag any file from the File Manager and drop it onto the minimized Pegasus Mail icon 
and it will do one of two things: if the frontmost window within Pegasus Mail is a message editor 
window, WinPMail will add the file as an attachment to that message; if the frontmost window is not a 
message editor, Pegasus Mail will begin a new message with the file added as an attachment.



Quick Folders

Pegasus Mail lets you define up to six Quick Folders that you can access with a single keystroke from the
Folder Manager window and when browsing the contents of a folder.

To define your Quick Folder settings, choose Define quick folders from the Quick copy/move submenu of 
the Folder menu (if you are browsing a folder), or from the Quick open submenu of the Folders menu (if 
you are working in the Folder Manager's window). You will be presented with a dialog containing six 
entries that look like this:

Click the large button to select the folder which you want to associate with each quick folder entry. The 
folder's long name will appear next to the button once you have selected it. The Move and Copy radio 
buttons allow you to choose whether any messages you have selected while browsing a mail folder should
be moved or copied into the quick folder when you activate it. You do not have to define all the Quick 
Folders in the dialog - you can define as few or as many as you wish, and you can define them in any 
order.

To use a Quick Folder definition, either select it from the submenu in the Folder or Folders menus, or 
hold down the Ctrl key and press the number of the Quick Folder you want to access. If the Folder 
Manager window is frontmost, this will open the Quick Folder; if a mail folder is the frontmost window, 
any messages selected in it will be moved or copied to the quick folder, depending on you Quick Folder 
settings.

If you want to be able to perform moves or copies into quick folders while browsing a folder simply by 
pressing the number of the Quick Folder (i.e, without having to hold down the Ctrl key), check the control
labelled Allow activation without pressing Ctrl when in folder windows at the bottom of the definition 
dialog.



Configuring Pegasus Mail

Pegasus Mail configures itself automatically for use in the Novell NetWare environment, but when 
running in other environments requires a small amount of information the first time it runs. The 
information you give it will determine how it operates for you and depends on how you plan to use the 
system.

Single user configuration
One user on this computer and only one address.

Multi-user configuration
More than one user on this computer, or if
 you have more than one address.

Network configuration
For multiple users on non-NetWare networks.



Single user configuration

Click the single user button in the configuration dialog if there will only ever be one person with a single 
e-mail address running Pegasus Mail on this computer. This is the simplest configuration option - if you 
select it, Pegasus Mail will simply ask you for the name of a directory on your computer where your mail-
related files should be stored.

The name of the directory you enter must be a full path (for example, "C:\PMAIL\MAIL"). If you use a 
partial path (such as "MAIL", "..\MAIL" or "C:MAIL") you may run into unpredictable problems later 
on. You do not have to enter an existing directory path: Pegasus Mail will create all or any portion of the 
path you enter as required.

You should not use the directory where you have installed WINPMAIL.EXE as the mailbox directory you
enter here - if you do, you will see two occurrences of all your mail-related files, such as folders and 
distribution lists. This is because Pegasus Mail regards any files of these kinds which it finds in its 
installation directory as system wide files, and thus presents them to you twice - once as your own files 
and once as system-wide entries.



Multi-user configuration

Click the multi-user button if you want to allow more than one person to use Pegasus Mail on this 
computer, each having different mailboxes and preference files. In multi-user mode, Pegasus Mail will 
prompt for a username when it is run, or the -I command line option can be used to create an icon which 
will start the program with the proper user information. You can also use this option if you send and 
receive mail using more than one e-mail address, by creating a separate user account for each address.

When you select this option, Pegasus Mail will ask you for a path to the directory where it should create 
and look for user mailboxes. The path you enter must be a full path from the root of a drive and should 
not end in a trailing '\' character. The path need not exist - Pegasus Mail will create it for you if required.



Network configuration

Click the network button if you want to use Pegasus Mail on a network for which it does not have explicit
support, such as LANtastic or Windows for Workgroups. Running in network mode differs from multi-
user mode only in that the path you enter for the new mailbox locations must exist on a shared volume 
available to all mail system users. Pegasus Mail will wait while you mount the volume you want to use 
and then will proceed with a regular multi-user installation.

Considerations for network use

* The shared drive on which the mailboxes are located must be mounted before you run Pegasus Mail - 
Pegasus Mail will not mount it for you.

* All users must be able to access the shared volume using the same drive letter. If your network supports 
the UNC path format (i.e, \\SERVER\VOLUME\PATH) then you can enter the path using this format 
instead of a path based on a drive-letter.

* On some networks where the file server is actually a user's workstation (for instance, Windows for 
Workgroups) you may find that the user running on the file server cannot see the shared volume using the 
same drive letter as other users on the network - for example, the file server's C: drive may be visible to 
other users on the network as drive K:. If this is the case, you will have to create an alternate 
configuration file for that one user. To use an alternate configuration file, you must start WinPMail with 
the command line

WINPMAIL -e <filename>

filename must have no path component and may have 11 characters or fewer. It will be created in the 
same directory as WINPMAIL.EXE, so you must have write access to that directory when creating an 
alternate configuration. When creating an alternate configuration to cover a file server user, you should 
enter the path to the same mailbox location as your other users, just using the local path notation instead 
of the network path specification; otherwise, proceed with the configuration exactly as you did for your 
regular users.

If your network supports access control rights, then you can increase the security of the mail system by 
granting users all rights to their own mail directory but only sufficient rights to create files in all other 
users mail directories.



Command-line options

Pegasus Mail is able to run in a very wide range of environments using a wide variety of message formats
and transports. This versatility means that the program has a very rich selection of configuration options 
(as you can see by looking through the various preferences screens in the program). Some of the more 
specialised configuration options, as well as options for sending mail automatically, are accessed by 
passing parameters to the program on its command line. The command line is a set of parameters which 
the Windows Program Manager can pass to Pegasus Mail at startup, and is part of the Properties of the 
icon you create for Pegasus Mail. To change the commandline for Pegasus Mail, select its icon in the 
Program Manager and press <Alt+Enter>, or else choose Properties from the File menu.

Pegasus Mail for Windows recognizes the following commandline options: where an option has a 
parameter, you must place a space on the commandline between the option and that parameter.

Message submission options (sending mail from the commandline)
-T <address>
Specify the primary addressee of the message
-F <filename>
Specify the file which should be sent as the body of the message
-B (no parameter)
If present, indicates that the file is binary and should be attached.
-C <address>
Specify Carbon Copy (CC:) recipients of the message
-S <"Subject">
Specify the message subject (must appear in quotes)
-J <filename>
Advanced job submission

Run control options
-A (no parameter)
Forces WinPMail to run in standalone mode, ignoring any NetWare connection.
-V <keyword=parameter>
Define an entry in WinPMails environment table. This has the same effect as defining the variable in your
AUTOEXEC.BAT file using the SET command, and is primarily useful for specifying things like the 
noticeboard directory, or values that can be substituted into User-Defined Gateway commandlines.
-P <server>
Forces WinPMail to use a NetWare Bindery connection to the specified server. You must already have a 
valid attachment to the server. Use this option if you regularly connect to more than one NetWare 3.x 
server.
-U <username>
"Become" another user for the duration of the session. In NetWare mode, you must belong to a group 
called BECOME to be able to use this flag, and must have proper rights to the target user's mailbox and 
new mail folder on the file server.
-I <username>
Specify your standalone identity on the commandline. This flag only operates in standalone mode (it is 
ignored in NetWare mode) and differs from -U in that you are not actually becoming another user - you 
are simply identifying yourself, so WinPMail takes fewer security precautions against mail forgery.
-O (no parameter)
Enter offline mode. In offline mode, WinPMail will ignore all commands or situations in which it might 
normally initiate a check for new mail using its built-in TCP/IP mail transport. This effectively allows you



to use the program as if you were connected to your service provider without actually establishing a 
connection.
-E <filename>
Instructs Pegasus Mail to use an alternate standalone configuration file: by default, Pegasus Mail looks 
for a configuration file called PMAIL.CFG in the directory where it is installed to find its standalone 
configuration information. This option allows you tell it to use an alternative filename, although the 
filename you give must have no path attached to it and the file must still reside in the same directory as 
WINPMAIL.EXE. This option is ignored in NetWare mode.
-Q <address>
If your WINSOCK.DLL has a defective gethostname() function, you may need to specify the address 
of your machine on the commandline using this option. Pegasus Mail must know the name or address of 
your own machine in order to be able to start a mail transaction when sending mail - usually it can get this
information    by asking your WINSOCK.DLL, but some WinSock implementations are faulty in this area.
<address> should be either your machine's Internet domain name if you have one (example: -Q 
calliope.pmail.gen.nz) or else a dotted IP address for your machine (example -Q 
192.156.225.64). If you are using a SLIP or PPP connection where your IP number is assigned 
dynamically and hence is not known in advance, then you may find that you can get things working either
by using the address -Q 0.0.0.0 or by using a fictitious name - something like -Q unknown. You 
should usually only use this option when you get an error from WinPMail specifically advising you to do 
so. If you need to use this commandline option, you should immediately get in touch with the supplier of 
your WINSOCK.DLL and ask if they have a version where gethostname() works correctly. If they cannot 
supply an updated version that works properly, you should consider moving to a different 
WINSOCK.DLL.
-W <path>
Allows you to force WinPMail to use a specific WINSOCK.DLL file instead of using the standard 
Windows search algorithm to find it. Handy if you have multiple WINSOCK implementations installed, 
or if you need to use one which cannot be found by the standard Windows search mechanism.
-X <language code>
Specify an internationalization module on the commandline. <language code> should be the two-letter 
code for the module you want to use - for example DE for the German module.
-Y <filename>
Specify an alternative name for the Pegasus Mail User Preferences file, PMAIL.INI. This switch tells 
Pegasus Mail that it should read and save all preferences information in the file you give, which must not 
have a path associated with it (it must be a simple filename). This is mostly useful if you run Pegasus 
Mail from two different machine with different screen resolutions, since it allows you to define settings 
specific to each machine.

-Z: The feature control flag

The -Z flag is used to enable a number of special case options within Pegasus Mail, and you will not 
normally need it in day to day use. The parameter to the -Z flag is created by adding together values from 
the following list:

1 Never load WINSOCK.DLL
4 Don't send NetWare Broadcast delivery notifications
16 Force the use of MIME encodings in noticeboards
32 Enter TCP/IP debugging mode
64 Use "From field" value to form the SMTP envelope address
128 "Blind load" WINSOCK.DLL - do not attempt to locate it first.
256 Open new mail folder at startup even if empty
512 Play new mail alert sound any time new mail arrives



(the sound usually only plays when minimized)
1024 Use blocking sockets; may be needed for some

defective WINSOCK implementations.
4096 Use blocking WINSOCK Name Resolution calls; may be

needed by some defective WINSOCK implementations.
8192 Use the broken commandline URL syntax expected by

MS Internet Explorer when invoking it with HTML files.

Other values are reserved and should not be used.



Advanced Job Submission

The most powerful way of submitting mail automatically to Pegasus Mail is via the -J command line 
option. The parameter to this commandline option should be a file formatted using Pegasus Mail's 
reloadable queue format - the same as is generated by the built-in TCP/IP transport and when you save a 
message as a draft. An RQF file is a rigidly-formatted text file using the following structure.

Line 1: A title line. This is ignored when using the -J option, but must be present.

Line 2 .. Line x: A sequence of header lines. Header lines consist of two characters, followed by a colon, 
followed by a data item of arbitrary length. Absent fields default to 0 or an empty string. The following 
header lines are recognized by Pegasus Mail (numbers in brackets indicate maximum field length for 
strings, or permissible values for integer types):

TO: The message's "To:" field (256)
SU: The message's "Subject:" field (65)
RE: The message's "Reply-to:" field (65)
CC: The message's "Cc:" field (256)
BC: The message's "BCc:" field (256)
EN: Whether or not to encrypt the message (1/0)
CS: Whether to keep a copy-to-self (1/0)
RC: Whether to request confirmation of reading (1/0)
FL: Message flags (currently not used)
DC: Whether to request confirmation of delivery (1/0)
UR: Whether or not to set the urgent flag (1/0)
SS: Whether to omit the message signature (1/0)
NB: Whether the message is destined for a noticeboard (1/0)
EX: Tagname of selected encryption module (12)
TN: Tagname of Extension that generated the message (12)
8H: Pre-formatted special RFC822 header to add to message
MH: Pre-formatted special MHS header to add to message
FI: If present, transmission is in the file named (65)
KY: Encryption key (48)
!M: Message width (20 < x < 254)
!T: Tab width (0 < x < 20)
AT: An attachment. The format for this field is:

<filename><,><attachment_type><,><encoding><,><original_name>
Note that no parameter may be omitted, spaces are significant and no parameter may contain a 
comma. "Encoding" specifies the encoding method for the attachment - in almost all cases it 
should be set to 0 to allow Pegasus Mail to select the most appropriate method. "original_name" 
is the real name for the file (the assumption is that "filename" may be a temporary file created for 
mailing only). "Attachment_type" can be any string but should usually be selected from the list of
available types in Pegasus Mail.

Line x + 1:    Exactly one blank line indicating end of headers / start of message

Line x + 2: .. End of file: Message text if no FI: header was specified.

Hint:    For an example of the layout of one of these files, prepare a message within Pegasus Mail turning 



on every message option, then save it as a draft and examine the .PMO file that gets created in your home 
mailbox.



Managing users

When running in multi-user mode, or on a non-NetWare network, Pegasus Mail maintains user mailboxes
in a single directory you choose the first time you run the program. You can create as many users as you 
wish for the system, each user having his or her own preferences files, mail folders, address books and so 
on. This versatility can also be useful for a single user who wishes to maintain multiple separate mail 
addresses.

The first time Pegasus Mail runs in multi-user mode, it will bring up the user management dialog to allow
you to create an initial set of users for the system. At any future time, any user designated an 
administrator can also select Manage users from the Addresses menu to add, remove or edit the details of 
mail system users.

Mail system users have three characteristics:

* A username:    A mail system user's username consists of eight or fewer letters or numbers and acts as 
that user's local mail address - that is, the address other mail system users will enter into Pegasus Mail to 
send mail to that user. The username is also the name of the mailbox directory Pegasus Mail will look for 
in your installation directory. All users must have a username, and every username on the system must be 
unique.

* A personal name:    A user's Personal name is a descriptive tag which appears in the local users list in 
Pegasus Mail. It is usually simply the user's first name and surname, but the exact format is up to you. 
Every user must have a personal name. The only restriction on a personal name is that it may not contain 
a semicolon character (";").

Administrative privileges:    A user with administrative privileges may add and delete users within the 
mail system and may change any user's details. If you are running on a system which actually has a 
privilege structure of its own, then administrative users must also have the necessary system-level rights 
to create and remove directories in the base mailbox directory. At least one user in the system must have 
administrator privileges.



Message Encryption and Decryption

Encryption is the process of scrambling the contents of a mail message so that only the authorised 
recipient can read it. If you are sending sensitive or personal material, you can gain extra security by 
encrypting it. An offshoot of encryption technology is an authentication technique called a digital 
signature: digital signatures provide a means of proving incontrovertibly that you wrote a particular 
message at a particular time; some digital signature techniques are acceptable as evidence in courts of law
around the world.

There is a very wide range of encryptors available, and in many countries, especially the United States of 
America and France, paranoid government agencies have done everything in their power to prevent 
encryption technology from becoming available to the general public, usually in the name of "national 
security". This has resulted in astonishing regulations such as the USA's "ITAR" export regulations, under
which encryption technology is regarded as a munition and cannot be exported without the approval of 
the NSA.

Pegasus Mail incorporates an encryptor which is adequate for day to day use (it is a variant of the old 
unix "crypt" program using DES to "seed" the encryption key). It also permits third-party developers to 
add their own encryption technology into the program in a seamless manner. Because of this, the specifics
of the encryption options available to you may vary from system to system.

When you select the Encrypt option in the message editor, Pegasus Mail will open the encryptor dialog. 
The topmost control in this dialog allows you to select the encryption technique you want applied to the 
message -- unless you have added third-party encryptors to your copy of Pegasus Mail, there will only be 
one entry in this list, Pegasus Mail's built-in encryptor. The other options in the dialog may become 
enabled and disabled depending on the technique you select -- not all encryptors will support digital 
signatures, for instance.

The password is usually your secret key to the message and will not display as you type it in. With some 
encryptors, the password may actually open your encryptor's key ring -- this will depend on particular 
instances. Some encryptors may place certain restrictions on the characters you can use in passwords -- 
consult the specific reference for each encryptor module to find out if this applies to you.

Default password button:  If you have defined a default encryptor passphrase in the Message editor 
settings page of your preferences, then you can enter it into either the encryption or decryption dialog by 
clicking the button labelled * at the right of the password field.

Pegasus Mail's built-in encryptor has the following characteristics:

* Passwords can be from 5 to 8 characters in length
* Passwords may not contain international characters
* The encryptor cannot produce digital signatures
* The encryptor cannot encrypt binary data such as attachments
* Only other users of Pegasus Mail will be able to decrypt its messages

The recipient of a message encrypted using Pegasus Mail's built-in encryptor must know the password 
you have used to encrypt it.



The Joke Page

Congratulations! You found the joke page.

Software developers are curious, stunted individuals with massive egos and towering (and usually wildly 
inflated) opinions of their own worth and ability... Pegasus Mail's author realises that he's probably no 
different from any other software developer in this regard. Accordingly, he has indulged himself 
outrageously by burying this completely pointless page in the help file to see if anyone finds it.

Your reward for enduring this string of platitudes and pointless observations is a short selection of some 
of my favourite quotable quotes -- you might like to use some of these in your variable signature, or, you 
might not... <grin>. Warning in advance - some of these quotes are probably not very politically correct, 
so if you're a pious or self-righteous person, you should probably stop reading this screen right now and 
return to your mail.

Definitions

Philosopher (n):    a blind person in a dark room looking for a black hat that is not there.

Bachelor (n):    a thing of beauty and a boy forever.

Erotic (adj):    using a feather as a sex aid.
Kinky (adj):    using the whole duck.

Newspaper glitches

"Ghana is to change over to driving on the right.
The change will be made gradually."

Iraqi head seeks arms

Two convicts evade noose - jury hung

Miners refuse to work after death.

Quotes from famous people

Wagner has beautiful moments, but awful quarter-hours.
-- Rossini

"Each time a New Zealander leaves for Australia the IQ of both countries goes up."
-- Rob Muldoon

A woman is only as old as the man she feels
-- Mae West

Signs seen around the world



Dreaded veal cutlet
-- On the menu of a Chinese Restaurant.

"Stop: drive sideways."
-- Detour sign seen in Kyushi, Japan

When the passenger of foot heave in sight, tootle the horn. Trumpet him melodiously at first, but if he still
obstacles your passage, tootle him with vigour

-- On the driver instructions in a Japanese rental car.

"Salad a firm's own make; limpid red beet soup with cheesy dumplings in the form of a finger; roasted 
duck let loose; beef rashers beaten up in the country people's fashion."

-- Seen on the menu of a Polish hotel

Cream dognuts
-- Seen on the menu of a Belgian hotel.

And finally

Remember, even if you win the rat race, you're still a rat...



Guidelines for Electronic Mail Etiquette

This section presents some simple guidelines for electronic mail etiquette. It does not try to mandate any 
particular style or rules: it is instead an attempt to highlight important issues affecting the clarity of the 
electronic mail we send. After all, electronic mail is about communication, so clarity should be our goal. 
This section is based on a document distributed widely around the Internet over the last few years, and is 
in no particular order.

Addresses and personal names

A Personal name is an arbitrary string many mailers will allow you to define that is attached to your e-
mail address as a textual comment: in Pegasus Mail, you define your personal name in the General 
Preferences dialog.

* Always provide a personal name if your mail system allows it - a personal name attached to your 
address identifies you better than your address can on its own.

* Use a sensible personal name: "Guess who" or other such phrases are annoying as personal names and 
hinder the recipient's quick identification of you and your message.

* If your mail system lets you use personal names in the addresses to which you send mail, try to use 
them. This will often help a postmaster recognize the real recipient of the message if the address is 
invalid.

Example:
The address 344188@foo.chaos.com conveys less information
than if it were written as 344188@foo.chaos.com (Ford Prefect)

Subject lines

* Always include a subject line in your message. Almost all mailers present you with the subject line 
when you browse your mailbox, and it's often the only clue the recipient has about the contents when 
filing and searching for messages.

* Make the subject line meaningful. For example, sending a message to WordPerfect Technical Support 
with the subject WordPerfect is practically as unhelpful as having no subject at all.

* If you are replying to a message but are changing the subject of the conversation, change the subject 
too - or better still, start a new message altogether. The subject is usually the easiest way to follow the 
thread of a conversation, so changing the conversation without changing the subject can be confusing 
and can make filing difficult.

Message Length, Content and Format

* Try to match your message length to the tenor of the conversation: if you are only making a quick 
query, then keep it short and to the point.

* In general, keep to the subject as much as possible. If you need to branch off onto a totally new and 
different topic then it's often better to send a new message, which allows the recipient the option of 



filing it separately.

* Don't type your message in all-uppercase - it's extremely difficult to read (although a short stretch of 
uppercase may serve to emphasize a point heavily). Try to break your message into logical paragraphs 
and restrict your sentences to sensible lengths.

* Use correct grammar and spelling. Electronic mail is all about communication - poorly-worded and 
mis-spelled messages are hard to read and potentially confusing. Just because electronic mail is fast 
does not mean that it should be slipshod, yet the worst language-mashing I have ever seen has been 
done in e-mail messages. If your words are important enough to write, then they're also important 
enough to write properly.

* Avoid public "flames" - messages sent in anger. Messages sent in the heat of the moment generally 
only exacerbate the situation and are usually regretted later. Settle down and think about it for a while 
before starting a flame war. (Try going and making yourself a cup of coffee - it's amazing how much 
you can cool down even in that short a time, besides which a cup of good coffee is a great soother).

* If your mail program supports fancy formatting (bold, italic and so on) in the mail messages it 
generates, make sure that the recipient has a mail program that can display such messages. At the time 
of writing, most Internet mail programs do not support anything other than plain text in messages, 
although this will change over time.

* Be very careful about including credit card numbers in electronic mail messages. Electronic mail can 
be intercepted in transit and a valid credit card number is like money in the bank for someone 
unscrupulous enough to use it. 

Replies

* Include enough of the original message to provide a context. Remember that Electronic Mail is not as 
immediate as a telephone conversation and the recipient may not recall the contents of the original 
message, especially if he or she receives many messages each day. Including the relevant section from 
the original message helps the recipient to place your reply in context.

* Include only the minimum you need from the original message. One of the most annoying things you 
can encounter in e-mail is to have your original 5-page message quoted back at you in its entirety, with
the words "Me too" added at the bottom. Quote back only the smallest amount you need to make your 
context clear.

* Use some kind of visual indication to distinguish between text quoted from the original message and 
your new text - this makes the reply much easier to follow. ">" is a traditional marker for quoted text, 
but you can use anything provided its purpose is clear and you use it consistently.

* Pay careful attention to where your reply is going to end up: it can be embarrassing for you if a 
personal message ends up on a mailing list, and it's generally annoying for the other list members.

* Ask yourself if your reply is really warranted - a message sent to a list server that only says "I agree" is
probably better sent privately to the person who originally sent the message.

Signatures



A Signature is a small block of text appended to the end of your messages, which usually contains your 
contact information. Many mailers can add a signature to your messages automatically. Signatures are a 
great idea but are subject to abuse; balance is the key to a good signature.

* Always use a signature if you can: make sure it identifies who you are and includes alternative means 
of contacting you (phone and fax are usual). In many systems, particularly where mail passes through 
gateways, your signature may be the only means by which the recipient can even tell who you are.

* Keep your signature short - four to seven lines is a handy guideline for maximum signature length. 
Unnecessarily long signatures waste bandwidth (especially when distributed to lists) and can be 
annoying.

* Some mailers allow you to add random strings to your signature: this is well and good and can add 
character if done carefully. You should consider the following basic rules though:

Keep it short. The length of your quote adds to the length of your signature. A 5,000 word excerpt 
from Kant's 'Critique of Pure Reason' used as a signature will not win you many friends.

Definitions of "offensive" vary widely: avoid quotes that might offend people on the grounds of 
religion, race, politics or sexuality.

Avoid topical or local quotes, since they may be meaningless to recipients in other towns, countries or 
cultures.

Variable signatures are usually best if they're amusing; polemical outbursts on politics or other such 
topics will turn most people off, but a one-liner that brings a smile can make someone's day.

Courtesy

Electronic mail is all about communication with other people, and as such some basic courtesy never goes
amiss.

* If you're asking for something, don't forget to say "please". Similarly, if someone does something for 
you, it never hurts to say "thank you". While this might sound trivial, or even insulting, it's astonishing
how many people who are perfectly polite in everyday life seem to forget their manners in their e-mail.

* Don't expect an immediate answer. The fact that you don't get an answer from someone in ten minutes 
does not mean that he or she is ignoring you, and is no cause for offense. Electronic mail is all about 
dealing with your communications when you are able to do so.

* Always remember that there is no such thing as a secure mail system. It is unwise to send very 
personal or sensitive information by e-mail unless you encrypt it using a reliable encryptor. Remember
the recipient - you are not the only person who could be embarrassed if a delicate message falls into 
the wrong hands.

* Include enough information: if you are sending in a question to which you expect a response, make 
sure you include enough information to make the response possible. For example, sending the message
My spreadsheet program doesn't work to Lotus Technical Support really doesn't give them very much 
to work with; similarly, sending the message What has happened to my order? to a vendor is also 



unhelpful. When requesting technical support, include a description of the problem and the version of 
the program you're using; when following up on an order, include the order number, your name and 
organization, and any other details that might assist in tracing your order - and so on.

"Smiley faces" (Emoticons)

Electronic mail has very nearly the immediacy of a conversation, but is totally devoid of "body language".
The Internet "counter-culture" has had an answer to this problem for years - "smiley faces", or groups of 
ASCII characters that are meant to look like a face turned on its side.

The most common smiley faces are probably these:

:-) or :) A smiling face seen side-on; generally used to indicate amusement, or that a comment is 
intended to be funny or ironic ("<g>" or "<grin>" is also sometimes used).

:-( or :( An unhappy face seen side on; generally used to express disappointment or sorrow.
;-) A winking smiley face; usually indicates that something should be taken "with a grain of 

salt".
;-> A mischievous smiley face; usually indicates that a comment is intended to be 

provocative or racy.

There are hundreds of others, some more recognizable than others.

Using the common smiley faces carefully can markedly improve the clarity of your message, since they 
convey nuances which approximate "body language". Like any embellishment, however, overuse of 
smiley faces destroys their value - use them sparingly.

The Bottom Line

Above all else, remember that electronic mail is about communication with other people. When you 
compose an e-mail message, read it over before sending it and ask yourself what your reaction would be 
if you received it. Any time spent on making our e-mail clearer is time well-spent, so let's start taking the 
time.



Viewing attachments

When you receive mail with attachments, you may wish to view the contents of the attachment without 
leaving Pegasus Mail: you can do this provided Pegasus Mail can find an application on your system that 
is capable of displaying the type of file contained in the attachment. When looking for a suitable viewer, 
Pegasus Mail can use either the extension of the filename for the attachment, or if the attachment has 
attachment type information associated with it, it can use that.

There is no absolute way of identifying that a particular application can open any particular file, but 
Pegasus Mail uses the following method when attempting to find one:

* If you have defined an explicit viewer using the Attachment Viewers option on the Preferences menu, 
Pegasus Mail will use that viewer.

* If no viewer has been defined explicitly, it scans the [Extensions] section of your WIN.INI file looking 
for applications that have stored associations there.

If no suitable viewer can be found, the View button in the attachments dialog will be disabled. If a suitable
viewer is available, Pegasus Mail will create a temporary file containing the data from the attachment and
will run the viewer application, passing it that file to open. If you click the Save and Edit button instead of
the View button, Pegasus Mail will create a permanent file instead of a temporary file. In no case can you 
ever actually alter the data of the attachment itself using a viewer.

Defining a viewer

To define your own viewers for different types of attachments, choose the Attachment Viewers option on 
the Preferences menu. Click Add to create a new entry, or double-click an existing entry to edit it. Next, 
decide whether Pegasus Mail should examine the file's extension when deciding whether or not to use this
definition, or else examine the file's attachment-type information. It is reasonable, and in fact often even 
necessary to create two entries in the list, one to select by extension and the other to select by attachment 
type.

If you choose to select by extension, you should then type in the extension Pegasus Mail should look for 
when examining the file. If you choose to select by attachment type, you can either select an attachment 
type from the standard list of types Pegasus Mail knows about, or else you can type in any other type you 
know you receive. Note that you must type the attachment type in accurately and completely - Pegasus 
Mail only does exact matching on this information.

Once you have worked out the conditions that need to be matched for Pegasus Mail to use this definition, 
you can click the OK button to save the definition. If you get an error from Windows when you try to 
view an attachment, or if nothing happens when you click the View button, you may have to uncheck the 
control labelled "Let Windows choose an appropriate application" and enter the name of the application 
Pegasus Mail should run to view the document. Click the Browse button to use a list to choose your 
application.

Extension to use for temporary file:    Many applications will only load documents if the extension of the 
file is one they know. If someone sends you a file of a particular type with a different extension, then the 
application will refuse to open it. To get around this, Pegasus Mail allows you to force the use of a 
particular extension in the filename of the temporary file it creates and passes to the viewer application. A 
good example of this might be with JPG graphic files: most Windows-based graphic viewers expect the 
extension for JPG files to be .JPG, but if you receive such a graphic from a unix system, where the 



conventions are different, it will usually have the extension .JPEG. To handle cases like this, you would 
enter .JPG into this field to force Pegasus Mail to create the file using the extension .JPG instead of the 
unix name.

Selecting special MIME types: MIME is a special Internet message format which can represent the type 
of data in an attachment in special ways, many of which are not standard. Although it is very technical, 
you can tell Pegasus Mail to use a viewer for particular MIME document types by entering the MIME 
data type in the Attachment type field. For example, if someone sends you GIF images using the MIME 
data type Image/GIF, you can define a viewer for attachments of that type by entering Image/GIF in the 
attachment type field. This option should not normally be necessary and is provided for the benefit of 
advanced users working with their own special data types.



Filenames

Under MS-DOS and Windows, a filename consists of three parts

* Its path, which is the full name of the directory containing the file
* Its name, which can contain up to eight letters or digits
* Its extension, which is an optional group of three letters or digits separated from the filename by a 
single period (.).

A file's extension usually serves to identify the type of data the file contains - so for instance, a file called 
MYFILE.TXT would usually contain plain text, the .TXT extension indicating this. 

Under Windows 95, files can have much longer names, but they still can have an extension, and the 
extension still usually serves the same purpose.



Searching for data throughout your folders

Often you may know that you have received a message on a particular subject at some stage but have no 
idea which folder you stored it in. If you want to search through some or all of your folders for particular 
messages, open the Folder Manager window and select Find from the Edit menu. A dialog will open 
offering you options for your search.

In the Search for messages containing field, type in the words for which you would like Pegasus Mail to 
search. When searching, it looks for each word you enter separately and gives a relevance score to each 
message based on how many of the words you enter it contains, how close they are together in the 
message and on how exact the match is. When searching, it will match the words you enter both as whole 
words and as partial words -- so, if you enter agree as a word to search for, Pegasus Mail will match 
messages containing agree, disagree and agreement, but will score the message containing agree more 
highly because it is a more exact match. Choosing the words you want to search for carefully increases 
the likelihood of Pegasus Mail finding the exact message you are looking for. You can enter up to twenty 
words.

Search in allows you to control which folders Pegasus Mail should search, and how long it should spend 
doing it. Searching folders can be a very slow process, so Pegasus Mail allows you to limit the search to a
certain length of time. You can also halt the search at any time once you have started it by clicking Stop in
the progress dialog. You can limit the search to folders whose long names contain particular words or 
strings by clicking the Folders whose names contain control and typing in the characters Pegasus Mail 
should match. This can be very handy if you have organized your folders using consistent or specific 
naming conventions. Searching ignores trays - all your folders are candidates for searching even if they 
are in trays that are not currently open in the list.

If you check the control labelled Search in message headers only, WinPMail will limit its search to the 
special message headers for each message and will not search through the message body. This can result 
in a much faster search.

When you have filled out the fields in the dialog, click OK and Pegasus Mail will begin the search. As it 
finds candidate messages, it will display them in a results window, sorted by relevance, the most 
promising messages at the top of the list. You can see an indication of the relative relevance of a message 
by examining the bar at the left-hand side of each entry in the list -- the longer the bar, the more relevant 
WinPMail believes the message to be. You can stop the search at any time by pressing Stop in the 
progress dialog, and you can switch to other applications while the search is in progress. If you interrupt a
search, the results window will remain open with the messages found up to that point.

You can sort the messages in the result window by relevance, sender, subject or date; the default sort 
order is always by relevance. You can open any message in the result window by double-clicking it, or by 
highlighting it and pressing Open. The folder containing the message will also be opened with the 
message highlighted.



Clickable links

Pegasus Mail can detect URLs (Uniform Resource Locators), or hypertext links for the World Wide Web 
in your messages. When it finds a valid HTTP:, FTP: or MAILTO: URL in a mail message, it highlights it
by displaying it in underlined green text.

If you double-click a MAILTO: URL, WinPMail will simply start a new message using the address in the 
URL. For other URL types, if you have a Web Browser, such as Netscape or Microsoft Internet Explorer 
on your system, you can have WinPMail load the browser for you and open the link by double-clicking on
it in the message reader.

The first time you do this, WinPMail will open a window asking you to locate your web browser. In most 
cases, you can simply check the control labelled Find browser automatically. This tells WinPMail to use 
standard system resources to locate the proper browser to load and run. When this control is checked, 
WinPMail will activate your web browser if it is already running, and will instruct it to replace the page it 
is currently displaying with the one you double-clicked.

Some web browsers may not install themselves in a way that will allow the Find browser automatically 
option to run properly. When this is the case, nothing will appear to happen when you double-click a URL
in a message. To fix this situation, enter the path to your web browser in the edit control and make sure 
the Find browser automatically button is not checked.



Selectively downloading your mail messages

The process of retrieving your mail from your Internet Service Provider can be costly, especially if you 
have to make a toll call to do so. Pegasus Mail allows you to preview the contents of your POP3 mailbox 
before downloading it, by downloading only the message headers and showing them to you. Once the 
mail headers have been downloaded, Pegasus Mail terminates the connection immediately and allows you
to browse the headers from the messages at your leisure. You can indicate that you want to retrieve some 
of the messages from your mailbox and possibly delete others, then when you are ready, you can tell 
Pegasus Mail to reconnect and perform the actions you have specified.

To start a selective download from your POP3 mailbox, choose Selective Mail Download from the File 
menu. Pegasus Mail will start a connection to your POP3 host and will retrieve the headers of the 
messages it contains. If you have told Pegasus Mail to download only unread mail using the option in 
your Advanced configuration options settings, then the selective download will only retrieve the headers 
of messages you have not already seen. While it is downloading the message headers, you may continue 
to work on other things, or switch to other applications; the only thing you may not do while this 
operation is in progress is attempt to start a regular mail download or to send mail in your mail queue - 
Pegasus Mail will report an error if you attempt to do this. Once the header download is complete, 
WinPMail will open a window displaying the sender, subject, date and size of each message in the 
mailbox.

For each entry in the list, you may Retrieve the message, Delete the message, do both, or leave it 
untouched. Messages marked for retrieval will show a green dot in the R column at the right of the list, 
and messages marked for deletion will show a red dot in the D column.

To indicate that you want to retrieve a mail message from your mailbox to your local system, highlight 
the message and click the Mark for retrieval button. A green dot will appear next to the message, but 
nothing more will happen at this stage.

To indicate that you want to delete a mail message from your mailbox, highlight the message and click 
the Mark for deletion button. A red dot will appear next to the message and it will display in red, but 
nothing more will happen at this stage.

To indicate that you want to retrieve a message from your mailbox then delete it, either click both buttons,
or more conveniently, click the Mark for both button.

You can mark more than one message by holding down Shift or Ctrl as you click in the list. The 
Mark for Retrieval, Mark for Deletion and Mark for both buttons will tag all selected messages.

Once you have marked the messages you wish to retrieve and delete, click the button labelled Make it so 
(apologies to Star Trek). This tells Pegasus Mail to open another connection to your POP3 host and take 
all the actions you have specified. If any messages are downloaded successfully as a result of the 
connection, they will appear in your new mail folder, which will open or resynchronize itself 
automatically to display them.

Important notes:

Messages marked for both retrieval and deletion will only be deleted if they are actually retrieved 
successfully.
Messages not marked for deletion will not be deleted from the remote mailbox, even if you have 
turned on Delete mail from host once successfully retrieved in your Advanced configuration 



options settings.



Terms and conditions of use

Pegasus Mail is free software and may be used by any number of users on any number of systems without fee or 
obligation, subject only to the terms and conditions laid out below.

Pegasus Mail is NOT in the public domain - the author, David Harris, retains ownership and copyright, and 
exclusively reserves all rights to the software. In countries where assertion of the right to be identified as the author 
is required for copyright purposes, David Harris asserts his right to be recognized as the author and owner of the 
Pegasus Mail System and all its associated components.

Modification of the program or its resources or associated data files without the author's explicit written permission 
is strictly forbidden. Unauthorised modifications of any component of the Pegasus Mail System are a breach of 
intellectual property laws in most countries and will be pursued vigorously to the full extent of the law.

Pegasus Mail may be used by anyone and may be freely distributed via any medium, either commercial or non-
commercial, provided the following conditions are met:

1: Distribution    The Pegasus Mail Software must be distributed complete and unaltered in the original ZIP 
archive file or self-extracting archive, with all messages intact. Removing or modifying any part of the 
system, including ZIP comments, is expressly forbidden. In the event that the Pegasus Mail software is 
being distributed as part of another package or software bundle, or in association with software or services 
for which a charge is being levied, the authors permission must be obtained before distribution occurs. We 
will authorise by fax or by an e-mail message signed with our public key signature at our discretion. Bona 
fide Internet Service Providers are exempted from the requirement to obtain formal permission (see section 
5, below).

2: Charging for distribution    No charge may be directly levied for Pegasus Mail itself. Fair copying and 
support charges may be applied but you must not represent that you are actually selling the software itself. 
The intent of this statement is to allow book publishers to distribute the system freely with books, and to 
permit Software Libraries and BBS systems to distribute Pegasus Mail in their catalogues provided only 
reasonable handling and duplication fees are charged.

3: Prohibited supply    The supply or promotion of Pegasus Mail for the purpose of sending bulk, unsolicited 
e-mail is incompatible with the basic aims of the program, which revolve around the free provision of a 
service that enhances the quality of communication between people. Pegasus Mail may not be included in 
any package designed for this purpose, whether free or otherwise, nor may vendors of such packages use 
the "Pegasus Mail" trademark or other related material in the promotion of their package. Similarly, we do 
not consider bulk, unsolicited e-mail to be an appropriate use of Pegasus Mail and reserve the right to 
decline technical support, or the sales of manuals to people using it for this purpose.

4: Ownership    Ownership of the Pegasus Mail Software remains vested in the author, David Harris. You may 
not represent ownership or copyright in the system in the course of distribution, and you must not represent 
any specific connection with, or authorisation or license from the author.

5: Distribution by ISPs    Bona-fide Internet Service Providers are explicitly granted permission to bundle the 
Pegasus Mail Software with their standard subscriber access package if they wish, even if a charge is levied
for that access package, provided the Pegasus Mail Software is supplied complete and unmodified and that 
it is part of a bundle. If you supply it as a separate item, you may only charge a reasonable duplication or 
handling fee and must otherwise abide by all other terms and conditions defined herein.

6: No liability    although all possible care has been taken to ensure that the Pegasus Mail Software is as 
reliable as possible, the diversity of environments in which it might be used means that we can accept no 
responsibility for loss or damage, whether real or consequential, arising from its use. By using the software 
you explicitly agree to hold the author blameless for any such losses or damages.



7: All rights reserved    we reserve the right to change the terms and conditions of use and distribution of 
Pegasus Mail without specific notice, although we will make reasonable efforts to advise of any such 
change through normal channels (user groups, mailing lists and so on). The current terms and conditions of 
use of Pegasus Mail can be obtained at any time by sending a message to tech-support@pmail.gen.nz 
requesting them.

All the legalese aside, it is my strong desire that Pegasus Mail be as widely used as is possible in the hope that by 
furthering communication between people, we may in some small way come to understand and accept each other 
better.




